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Welcome to Sprint®

We are committed to bringing you the best wireless technology available, and we 
built our network right from the start, so no matter where you are on the 
Nationwide Sprint PCS Network, all your services will work the same.

When it comes to mobile connectivity, the Sprint PCS Connection CardTM offers 
more freedom than ever before. No wires, no cables, just access to your data when 
you need it. The power of the Internet and company data is truly at your 
fingertips.

This guide will familiarize you with our technology and with your new 

Sprint PCS Connection Card and Sprint PCS Connection ManagerSM software 
through simple, easy-to-follow instructions.

Welcome and thank you for choosing Sprint.
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Introduction to This User’s Guide

This User’s Guide introduces you to Sprint PCS Service and all the features of your 
new wireless Sprint PCS Connection Card. It’s divided into six sections:

� Section 1:  Sprint PCS Connection Card Basics

� Section 2:  Installing the Sprint PCS Connection Card

� Section 3:  Using the Sprint PCS Connection Card

� Section 4:  Technical Specifications and Regulatory Information

� Section 5:  Safety Information and Terms & Conditions

� Section 6:  Glossary and Index

Throughout the guide, you'll find tips that highlight special shortcuts and timely 
reminders to help you make the most of your wireless PC Card modem and 
service.

The Table of Contents and Index will help you locate specific information quickly. 
The Sprint PCS Connection Manager software includes extensive online help to 
guide you through the steps to use each feature.

You'll get the most out of your new Sprint PCS Connection Card if you read each 
section of this document. However, if you'd like to get right to a specific feature, 
simply go to that page. Follow the instructions in that section and you'll be ready 
to use your card in no time.

Tip: You can view this guide online or print it to keep on hand. If you're viewing it 
online, simply click a topic in the Table of Contents, or a page number in the 
Index, or any page reference or section reference. The PDF automatically displays 
the appropriate page.
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Basics





Section 1A: Introducing the Sprint PCS Connection Card      3

Sec tion 1A

Introducing the Sprint PCS Connection Card

In This Section

� Your Sprint PCS Connection Card

� CDMA Networks

� Package Contents

� About This Guide

This section introduces the basic features and functions of your Sprint PCS 
Connection Card, what is included with your card, and how to use this guide 
to get you started.
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Your Sprint PCS Connection Card

The Sierra Wireless AirCard 580 wireless WAN modem is a dual-band wireless PC 
Card for cellular and North American PCS networks. It enhances the functionality 
of your mobile computing devices by adding wireless data and 2-way messaging.

This card allows you to do the following (subject to feature availability), without 
using a wireline phone or network:

� Connect to the Internet, VPN, and corporate networks

� Send and receive email

� Receive short text (Web) messages

Your Sprint PCS Connection Card fits into a Type II PC Card slot (available on most 
notebook PCs).

CDMA Networks

The Sprint PCS Connection Card operates over a type of wireless network called 
CDMA (Code Division Multiple Access).

To use the Sprint PCS Connection Card, you need an account that gives you access 
to the CDMA network. Some features described in this manual may not be 
available with your account. For details of the services and accounts available, 
contact Sprint (page 27).

There are CDMA networks that operate in the frequency bands supported by 
the Sprint PCS Connection Card throughout North America and parts of Latin 
America, Asia, New Zealand, and Australia. However, each service provider 
operates a network that covers a limited geographical area within the overall 
CDMA coverage area.

The fee for service is usually higher when you are roaming (connecting to a 
network other than Sprint).

Sprint has “roaming” agreements with other service providers, so that you can get 
service outside of the coverage area of the PCS Vision network. For example, 
assuming you live in Seattle and travel frequently to Vancouver, you can obtain an 
account with a service provider in Seattle that has a roaming agreement with a 
service provider in Vancouver. You would then have local service in Seattle, and 
roaming service in Vancouver. (There may be additional charges for roaming 
service.)
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CDMA technology provides a variety of connectivity features, depending on your 
Sprint account:

� 1xEV-DO supports Internet connections with data rates up to 2.4 Mbps 
(downlink from the network) and 153.6 kbps (uplink to the network). Average 
data rates are roughly 700 kbps (downlink from the network) and 153.6 kbps 
(uplink to the network). Actual speed depends on the network conditions.

� 1X supports Internet connections with data rates up to 153.6 kbps (downlink 
from the network) and 76.8 kbps (uplink to the network). Actual speed depends 
on the network conditions.

You can set Sprint PCS Connection Manager to automatically establish a 
Sprint PCS Vision (1xEV-DO or 1X) packet data connection when it starts. If the 
packet data connection is lost, the connection is restarted automatically. This 
provides an “always-on” network connection (as far as permitted by network 
coverage). Once the connection is established, you can open your browser and 
connect to any web site that is accessible through the Internet, or access other 
Internet services (such as e-mail).

The connection is “active” when data transmission is occurring. If data 
transmission stops for a period of time (determined by the network), the 
connection becomes “dormant”; see page 35.

Package Contents

Your Sprint PCS Connection Card package contains the following components:

� Sprint PCS Connection Card by Sierra Wireless (Model AirCard 580)

� Getting Started guide

� Installation CD containing the Sprint PCS Connection Manager software and 
this document

� Warranty card

Tip: More information about CDMA networks is available on the CDMA Development 
Group Web site, www.cdg.org.

Tip: For pointers on optimizing your settings, see “How can I optimize my settings to 
achieve the fastest speeds and conserve data when accessing my corporate 
network?” on page 71.

http://www.cdg.org
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About This Guide

This user's guide is designed to provide you with all the information you need to 
install and use your Sprint PCS Connection Card by Sierra Wireless (AirCard 580).

� Section 1 (which you are reading) gives you an overview of the Sprint PCS 
Connection Card (AirCard 580).

� Section 2 provides step-by-step instructions for installing the Sprint PCS 
Connection Card and Sprint PCS Connection Manager software (page 13).

� Section 3 provides step-by-step instructions on using the card (page 29).

� Section 4 provides electrical, radio frequency, and other parameters of the 
Sprint PCS Connection Card for those who require technical information, as 
well as regulatory information (page 77).

� Section 5 provides important safety and liability information and the Terms and 
Conditions of use for the Sprint PCS Connection Card (page 91).

� Section 6 include a glossary (page 107) and index (page 111).

Note: The comprehensive Getting Started guide that comes with the 
Sprint PCS Connection Card should be sufficient for most installations.
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Sec tion 1B

Getting Started With Your Sprint PCS Connection Card

In This Section

� Getting Started

� System Requirements

� The Sprint PCS Connection Card Software

� Care and Maintenance

This section describes the basics of getting started with your Sprint PCS 
Connection Card, and how to look after your Sprint PCS Connection Card.
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Getting Started

Before you begin using your AirCard 580 Sprint PCS Connection Card, you must:

1. Check that your notebook has the system requirements listed on page 8 
(“System Requirements”).

2. Install the Sprint PCS Connection Manager software, located on the 
installation CD, onto your Notebook PC. See page 16.

3. After you restart your computer, start Sprint PCS Connection Manager.

4. Insert the Sprint PCS Connection Card; this installs the drivers for the card. See 
page 20.

5. Activate your Sprint PCS account and configure the Sprint PCS Connection 
Card to use your account (unless the card has been pre-activated). See 
page 24.

System Requirements

The AirCard 580 Sprint PCS Connection Card is supported on:

� Windows 2000 with Service Pack 1 or later (Service Pack 4 is recommended), 
with high encryption support (see “High Encryption Requirements” on page 9)

� Windows XP (Home and Professional versions)

Subject to feature availability, the AirCard software supports Outlook integration, 
allowing you to read SMS messages in Outlook. To use Outlook integration, you 
require:

� Windows 2000 or XP, and

� Outlook 2000 or newer (Outlook Express is not supported).

On Windows 2000 and XP, the AirCard software also allows you to monitor 
connections with a WiFi network adapter.

CAUTION: Do not insert the Sprint PCS Connection Card into the PC Card slot 
until you have installed and run Sprint PCS Connection Manager 
software, and the software displays “Insert Your Card”.
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To install and run the Sprint PCS Connection Card and accompanying Sprint PCS 
Connection Manager software, you require the system resources shown in the 
following table.

High Encryption Requirements

Depending on your configuration, an IOTA session may automatically start as part 
of the installation/activation process. IOTA requires high-security 128-bit 
encryption, to establish a secure Internet connection to the CDMA network.

If you are running Windows XP, your computer should already include high-
security 128-bit encryption.

If you are running Windows 2000 with Internet Explorer
1. Ensure you have installed the Windows 2000 High Encryption Pack: in Internet 

Explorer, select Help > About Internet Explorer.

If you see a line “Cipher Strength: 128-bit”, then the High Encryption Pack is 
installed. Proceed to step 2.

If the High Encryption Pack is not installed, download and install it 
(www.microsoft.com/windows2000/downloads/recommended/encryption).

2. If your version of Internet Explorer is earlier than 5.5, download and install the 
latest version (www.microsoft.com/windows/ie/downloads).

Card slots One Type II PCMCIA (PC Card) slot

Communications ports 1 available

Disk drive CD-ROM

I/O resources 1 IRQ, 40 bytes I/O space

Memory 32 MB

Disk space 20 MB

www.microsoft.com/windows/ie/downloads
www.microsoft.com/windows2000/downloads/recommended/encryption
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If you are running Windows 2000 with Netscape Communicator

Ensure your version of Netscape Communicator is 4.7 or higher.

To verify that your version supports 128-bit encryption:

1. In Navigator, select Help > About Navigator. 

– or –

In Netscape Communicator, select Help > About Communicator.

2. See the section “Contains encryption software from RSA Data Security, Inc.” 

If the next paragraph states “This version supports U.S. security”, you have 
128-bit security.

If the paragraph states that you have International security, you have 40-bit 
security. Download a version that supports 128-bit security.

The Sprint PCS Connection Card Software

The Sprint PCS Connection Card comes with the following software:

� Sprint PCS Connection Manager, which allows you to manage the card's actions 
and monitor your connections.

� The driver software that forms the interface between the Sprint PCS 
Connection Card and your Windows operating system.

Before you insert the Sprint PCS Connection Card for the first time, you must 
install and then run the Sprint PCS Connection Manager software. The driver 
software is installed the first time you insert the card into your computer.

Detailed instructions are provided, beginning on page 16.
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Care and Maintenance

As with any electronic device, the Sprint PCS Connection Card must be handled 
with care to ensure reliable operation. Follow these guidelines in using and storing 
the card:

� Do not apply adhesive labels to the card, as they may cause the card to become 
jammed inside the card slot.

� The card should fit easily into your PC slot. Forcing the card into a slot may 
damage connector pins.

� Protect the card from liquids, dust, and excessive heat.

� When not installed in your computer, store the card in a safe place.

� When storing or transporting your computer, remove the Sprint PCS Connection 
Card.

� Optimal signal strength is usually obtained when the antenna is perpendicular 
to the card (see the picture below). The antenna should bend easily at the 
hinge. Do not forcefully bend the antenna.

� When removing your Sprint PCS Connection Card, always grip it by the sides of 
the card rather than the top. Never insert or remove the card while holding the 
antenna, as this action will damage the card.

� Do not use the Sprint PCS Connection Card with a handheld computer; it is only 

designed for notebook computers running Windows® 2000 or XP.

� If driving or operating a vehicle, do not handle or operate the Sprint PCS 
Connection Card. Doing so may distract you from properly operating the 
vehicle. In some states and provinces, operating communication devices while 
in control of a vehicle is a criminal offense.
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Sec tion 2A

Installing the Software

In This Section

� Getting Started

This section explains how to install your Sprint PCS Connection Manager software.

The process may vary, depending on the operating system that you are running.
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Getting Started

Before you can use your Sprint PCS Connection Card, you must first install the 
card's software and configure the card for your computer. The installation process 
consists of:

� Software installation - Installing the Sprint PCS Connection Manager software on 
your computer (described in this section).

� Card insertion and driver installation - Starting the Sprint PCS Connection 
Manager software and inserting the Sprint PCS Connection Card, which 
automatically installs the drivers on your computer.

� Card activation and provisioning - Activating your Sprint PCS account and 
configuring your Sprint PCS Connection Card to use your account (see “Setting 
Up Service” on page 23).

1. If the installation CD is not already in your CD-ROM drive, insert it.

The CD should autostart.

If the CD does not autostart, select Start > Run and enter d:\AC580SCM.Msi, 
where d is the drive letter of your CD-ROM drive.

NOTE: For comprehensive instructions on installing the Sprint PCS Connection 
Manager software and activating the card, see the Getting Started guide.

CAUTION: Do not insert the Sprint PCS Connection Card into your PC Card slot before 
installing the software.

NOTE: If you’re running Windows 2000, you must be logged in with administrative 
privileges to install the software. If you’re running Windows XP, you may 
require administrative privileges, depending on your XP settings.
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2. Use the Next and Back buttons to navigate through the wizard noting the 
following:

� You must select I accept the terms in the license agreement to indicate your 
acceptance of the terms of the license agreement to proceed with the 
installation.

� Use the default settings for the Destination Folder unless you have special 
requirements and an advanced understanding of PC configuration. (The 
Destination Folder dictates where the software is installed.)

� To install the optimization software (optional; this software can increase 
your perceived system speed), in the Installation Options window, select 
the check box for the Optimization Client.

3. At the end of the installation, you will be prompted to restart your computer. 
Ensure you save your work in other applications, if applicable.

4. When the “Installation Complete!” window is displayed, click Restart, to 
restart Windows.

5. When Windows has restarted, run Sprint PCS Connection Manager 

(double-click the program's icon  on your desktop).

6. Once Sprint PCS Connection Manager displays “Insert Your Card”, insert the 
card into the PC Card slot (see page 20).

Windows will detect the card and install the drivers for it. This may take a few 
minutes. Once completed, Sprint PCS Connection Manager should display 
“Disconnected”.

Proceed to configure the Sprint PCS Connection Card to use your account (if it was 
not pre-activated); see “Activating and Using Sprint PCS Service” on page 24. If 
your card is pre-activated, then you are ready to connect to the network; to learn 
about using the software, proceed to “Your Sprint PCS Connection Card: 
The Basics” on page 31.

NOTE: If you have an older version of Sprint PCS Connection Manager and are 
experiencing problems during installation, use the Add/Remove Programs 
Utility (see page 47) to remove the older version of Sprint PCS Connection 
Manager. Then reinstall the current version of Sprint PCS Connection 
Manager from the Installation CD.
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Sec tion 2B

Inserting and Removing the Sprint PCS Connection Card

In This Section

� Inserting the Sprint PCS Connection Card

� Removing the Sprint PCS Connection Card

This section describes how to properly insert and remove the Sprint PCS 
Connection Card from your PC.
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Inserting the Sprint PCS Connection Card

To insert the Sprint PCS Connection Card into a notebook:

1. With the picture label facing up, insert the network card into the PC Card slot.

2. Raise the antenna so that it is fully extended and pointed up at a 90° angle.

When you insert the AirCard, the following should occur:

� The first time the card is inserted, Windows detects the card and installs the 
drivers for it. This may take a few minutes. Once completed, Sprint PCS 
Connection Manager should display “Disconnected”. To connect to the network, 
click GO.

� If sound effects are enabled, the PC beeps.

� The PC Card icon appears in the system tray, if it is not already displayed for 
another card, (and unless the feature has been disabled).

The Sprint PCS Connection Card is powered as soon as you insert it.
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Removing the Sprint PCS Connection Card

To remove the Sprint PCS Connection Card:

1. Exit Sprint PCS Connection Manager if it is open.

2. Click the PC Card icon in the system tray to display the option to stop the card.

3. Click:
Windows XP: “Safely remove Lucent USB OpenHost Controller”
Windows 2000: “Stop Standard OpenHCD PCI to USB Host Controller”

4. If a dialog box appears notifying you that it is safe to remove the card, 
click OK, or click the Close button .

5. Use the ejector to remove the Sprint PCS Connection Card from the slot. Do 
not pull the Sprint PCS Connection Card out by the antenna.

NOTE: Do not pull the Sprint PCS Connection Card out by the antenna.
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Sec tion 2C

Setting Up Service

In This Section

� Activating and Using Sprint PCS Service

� Preactivated Card

� Non-preactivated Card: Activation Wizard

� Data Provisioning (IOTA)

This section walks you through setting up service for your Sprint PCS Connection 
Card, after you have installed the Sprint PCS Connection Manager software 
(page 16) and inserted the Sprint PCS Connection Card.
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Activating and Using Sprint PCS Service

Before using your Sprint PCS Connection Card, you must have a Sprint PCS 
wireless network account set up. The process of setting up an account is called 
activation.

When the Sprint PCS Connection Card is inserted and Sprint PCS Connection 
Manager is started, it will detect if the card has been configured with an account 
(“preactivated”). If it has not, the Activation Wizard starts automatically.

Preactivated Card

If you received your Sprint PCS Connection Card in the mail or purchased it at a 
Sprint Store, it probably has already been activated.

To prevent unauthorized use, preactivated cards may have been set with a security 
lock. If so, Sprint PCS Connection Manager displays the message “Card Locked”.

To unlock your Sprint PCS Connection Card:

1. Click the  icon. (If is not visible, click  to expand Sprint PCS Connection 
Manager.)

2. In the Enter User Lock Code window, enter your four-digit lock code, and click 
OK. For security purposes, the code is not visible as you type.

After unlocking your preactivated Sprint PCS Connection Card, it is ready for use. 
See “Using the Sprint PCS Connection Card” on page 29.

Non-preactivated Card: Activation Wizard

If your card is not preactivated, please see the Getting Started guide included with 
your card.

If your Sprint PCS Connection Card is not preactivated, Sprint PCS Connection 
Manager automatically detects that no account has been configured when you 
run it for the first time. It then runs the Activation Wizard to guide you through 
the activation and configuration process.

To set up your account, you will be contacting Sprint.

Tip: If you can’t recall your lock code, try using the last four digits of either your 
Social Security number or Sprint PCS Phone Number, or try 0000. If none of 
these work, call Sprint Customer Service at 1-888-211-4PCS (4727).
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Before you call Sprint, have these things ready:
� Your Sprint PCS Connection Card

� Your Social Security number or Tax ID number

� Your billing address

� Your driver’s license number

� The city and state where the device will be primarily used

� A pen and paper to write down your account information. Your package 
includes a printed Getting Started guide, where you can record this 
information.

When you call Sprint, Sprint Customer Service will help you select your service 
plan and guide you through the activation process. They will also provide you with 
this information:

� Your card's activation code (gives you access to configure the account)

� Your card's phone number (MDN)

� Your card's MSID (Mobile System ID) code, used for WLNP (Wireless Local 
Number Portability) and to determine whether you are “home” or “roaming”

Stepping Through the Activation Wizard
If the Activation Wizard has not started automatically:

1. Ensure the Sprint PCS Connection Card is inserted, and Sprint PCS Connection 
Manager is running. If Sprint PCS Connection Manager is not running, select 
Start > Programs > Sprint > Sprint PCS Connection Manager (AirCard 580).

Sprint PCS Connection Manager should display “Disconnected”.

2. If Sprint PCS Connection Manager displays “Card Locked”, unlock the card 
(page 45).

3. Start the Activation Wizard: select MENU > Settings > Sprint PCS Vision - Sierra 
Wireless > Activation Wizard.

Once the Activation Wizard is running:

1. To begin activation of the Sprint PCS Connection Card, click Next.

2. Call Sprint at the phone number listed on the screen. Click Next.

3. Give the account representative your ESN (Electronic Serial Number) number 
as displayed by the Activation Wizard. Enter the activation code provided by 
the account representative and click Next.
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4. Enter the phone number (no spaces or hyphens) and, if not the same value as 
the phone number, the MSID value given by the account representative, then 
click Next.

A confirmation window will be displayed.

5. Confirm with the service representative that the information is correct. If it is, 
click Yes. If it isn't, click No, and re-enter the information.

6. Click Finish to close the Activation Wizard.

7. Wait a few moments for the Sprint PCS Connection Card to automatically 
reset. Depending on your configuration, an IOTA session may automatically 
start (“Data Provisioning [IOTA]”, below).

After Sprint sets up your account on the network, your Sprint PCS Connection Card 
should be configured and ready for use.

Data Provisioning (IOTA)

IOTA (Internet Over The Air), supported by some service providers (including 
Sprint), is an automated feature to perform account setup for you by making a 
connection to the CDMA network and using a secure Internet connection to 
download account parameters to your Sprint PCS Connection Card. To make this 
secure connection, IOTA requires that your computer support 128-bit encryption 
(see “High Encryption Requirements” on page 9).

Depending on your configuration, the first time Sprint PCS Connection Manager 
detects the activated card, an IOTA session may automatically start, during which 
status messages (“Updating User Profile…”) are displayed.

After this first activation, there may be changes to your account that require 
updating the parameters in the Sprint PCS Connection Card. If this is needed:

1. In the Device Info & Diagnostics window (page 64), click Update Data Profile. 
(If this button is not displayed, eject and re-insert the card.)

2. In the IOTA Provisioning window, click Yes.

Your Sprint PCS Connection Card then retrieves the updates to your data services 
account.

Once the updates are successful, Sprint PCS Connection Manager is displayed 
(“Disconnected”). You can now connect to the network.
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Sec tion 2D

Getting Help

In This Section

� Visit Our Web Site

� Contact Sprint Customer Service

� Troubleshooting

This section describes where you can find more information on Sprint PCS 
Services, options, and troubleshooting problems you have encountered.
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Visit Our Web Site

Stop by www.sprint.com and log on to get up-to-date information on Sprint PCS 
Services, options and more.

You can also:

� Review coverage maps

� Access your account information

� Add additional options to your service plan

� Check out frequently asked questions

� And more

Contact Sprint Customer Service

You can reach Sprint Customer Service by:

� Logging on to your account at www.sprint.com

� Calling us toll-free at 1-888-211-4PCS (4727)

� Writing to us at Sprint Customer Service, P.O. Box 8077, 
London, KY  40742

Troubleshooting

The Online Help for Sprint PCS Connection Manager (see page 43) includes 
descriptions of most common error messages. Look in the Contents under 
Troubleshooting.

For help with other problems:

� See “Troubleshooting Tips” on page 73.

� Consult the Sierra Wireless web site at www.sierrawireless.com, where you will 
find an extensive knowledge base that can be searched to address most 
problems, and the Installation Troubleshooting wizard (in the Support & 
Download section).

� Contact Sprint as noted above.

http://www.sprint.com
http://www.sprint.com
http://www.sierrawireless.com
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Sec tion 3A

Your Sprint PCS Connection Card: The Basics

In This Section

� Sprint PCS Connection Manager

� Starting Sprint PCS Connection Manager

� Start Sprint PCS Connection Manager Automatically

� Sprint PCS Connection Manager Window

� Connection States

� System Tray Connection States

� Determining the Type of Coverage

� Controlling the Sprint PCS Connection Manager Window

� Launching a Sprint PCS Vision Connection

� Viewing the Amount of Data Transferred

� Ending a Connection

� Online Help

� Displaying Your Phone Number

� Security

� Accessing Links

� Uninstalling the Sprint PCS Connection Manager Software

Your Sprint PCS Connection Card is packed with features that simplify your life and 
expand your ability to stay connected to the people and information that are 
important to you. This section guides you through the basic features of your 
Sprint PCS Connection Card.
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Sprint PCS Connection Manager

Sprint PCS Connection Manager is the application that allows you to manage and 
monitor the high-speed Sprint PCS Vision (1X and 1xEV-DO) connection to the 
Sprint PCS Vision network. You use Sprint PCS Connection Manager to:

� Determine your signal strength and other network connection parameters (page 33)

� Initiate data calls (page 41)

� View call statistics (page 62) and messages (page 35)

� Customize features and options (page 54)

Starting Sprint PCS Connection Manager

To start Sprint PCS Connection Manager:

1. Ensure the Sprint PCS Connection Card is inserted into the PC Card slot of your computer.

2. Adjust the antenna: optimal signal strength is usually obtained when the 
antenna is perpendicular to the card.

3. Double-click the program's icon  on your desktop, or:

(Windows XP:) From the Start menu on your Windows desktop, select 
Sprint PCS Connection Manager (AirCard 580), or select 
All Programs > Sprint > Sprint PCS Connection Manager (AirCard 580)

(Windows 2000:) From the Start menu on your Windows desktop, select 
Programs > Sprint > Sprint PCS Connection Manager (AirCard 580)

When Sprint PCS Connection Manager is running, it places an icon  in the 
system tray, usually at the right end of the taskbar. (See page 38.)

Tip: You can also set Sprint PCS Connection Manager to launch automatically 
whenever Windows starts (page 33).
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Start Sprint PCS Connection Manager Automatically

To set Sprint PCS Connection Manager to start automatically (when Windows starts):

� From the General option of the Settings window (page 55), select Launch when 
Windows starts.

Sprint PCS Connection Manager Window

The text (for example, “Connected” shown in the screenshot above) and icon(s) in 
Sprint PCS Connection Manager indicate the connection state (page 35), and also 

(only when Disconnected) the lock state (page 43) (locked  or unlocked ).

Note: Changes to this setting apply only after you restart Windows.

Tip: You can also set the Sprint PCS Vision connection to launch automatically 
whenever available (see “GO automatically when ready” on page 58). These 
two settings can provide an “always-on” connection, as long as you have 
Sprint PCS Vision network coverage.

Exit

Establish/Show/

Menu

hide
details cancel a

MinimizeMessage area Indicator area

connection
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Sprint PCS Connection Manager may display, depending on the connection state, 
some of the following icons:

Sprint PCS Connection Manager has the following buttons and text:

� Menu or the  button — Displays the Sprint PCS Connection Manager menu 
(page 50).

�  — Expands Sprint PCS Connection Manager and displays the amount of 
data transferred (when Connected), or, when Disconnected, the lock status of 

your card (locked  or unlocked ).

�  (Displayed when Sprint PCS Connection Manager is expanded) — Hides the 
amount of data transferred and the lock status of your card.

�  (upper right corner of the window) — Minimizes Sprint PCS Connection 
Manager (page 40).

CDMA network signal strength, indicated by the number of bars.

The ToolTip indicates the type of coverage you have (for example, 
1X or 1xEV-DO), and the signal strength, in dBm.

1xEV-DO transmit/receive icon: a data connection is active.

The up arrow is black and animated (for example: ) when data 
is being transmitted to the network.

The down arrow is black and animated (for example: ) when 
data is being received from the network.

1xEV-DO transmit/receive icon: the data connection is dormant. 
The up and down arrows are gray.

1X transmit/receive icon: a data connection is active.

The up arrow is black and animated when data is being 
transmitted to the network.

The down arrow is black and animated when data is being 
received from the network.

1X transmit/receive icon: the data connection is dormant. The up 
and down arrows are gray.

Data optimization/compression is in use (page 59).
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�  — Exits Sprint PCS Connection Manager.

� GO — Starts the Sprint PCS Vision connection (page 41).

� Stop — Ends the connection. (Visible when a connection is established.)

Connection States

Sprint PCS Connection Manager can display various connection/interaction states, 
including:

� Insert Your Card

� Initializing

� Updating User Profile… (See “Data Provisioning [IOTA] on page 26.)

� Searching for service...

� Disconnected

� Connecting

� Authenticating

� Connected

� Card Locked

Insert Your Card

Sprint PCS Connection Manager did not detect a Sprint PCS Connection Card. The 
GO button is unavailable.

Insert the Sprint PCS Connection Card. If it is already inserted, eject and reinsert it; 
wait a few moments. If this message is still displayed, uninstall (page 47) and 
reinstall Sprint PCS Connection Manager, or contact Sprint (page 27).

Note: The system tray icon also indicates the connection state (page 16).
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Initializing

Sprint PCS Connection Manager is attempting to establish communication with 
the Sprint PCS Connection Card.

Searching for service...

Sprint PCS Connection Manager is determining whether 1X/1xEV-DO service is 
available.

Disconnected

Sprint PCS Connection Manager is ready to make a connection to the network. The 

GO button is available, and the signal strength icon  and, if Sprint PCS 

Connection Manager is expanded, the lock icon (  or ) are visible.

To connect to the network, click GO.

Connecting

Sprint PCS Connection Manager is establishing a connection to the network.

Authenticating

The network is authenticating your user name and password.
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Connected

The connection is established. In addition to the signal strength icon , the 

transmit/receive icon (  for 1xEV-DO;  for 1X) is also displayed. If image 

optimization/compression is in use,  is also displayed (page 59).

If you expand Sprint PCS Connection Manager ( ), the amount of data 
transferred is shown. (See note on page 42.)

To end the connection, click Stop.

Card Locked

The card is locked. To use most of the features, you must unlock the card (page 45).
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System Tray Connection States

Sprint PCS Connection Manager has an associated icon  that appears in the 
system tray. The icon reflects the connection state.

Clicking the system tray icon toggles between displaying and minimizing 
Sprint PCS Connection Manager.

Right-clicking the icon displays the shortcut menu (page 52).

Determining the Type of Coverage

The ToolTip over the signal strength indicator  indicates the type of coverage 
you have (for example, 1X [synonym of 1xRTT] or 1xEV-DO):

Sprint PCS Connection Manager is not ready to connect to the 
network.

Disconnected — Sprint PCS Connection Manager is ready to make a 
connection to the network (page 36), or
Connecting — Sprint PCS Connection Manager is making a 
connection to the network (page 36).

Connected — Connection is established to the network; data 
transfer is in progress (page 37).

Dormant — Connection is established, but no data transfer is 
taking place.

Tip: The type of coverage is also displayed in the lower left part of the Device Info 
& Diagnostics window under “Network Service” (page 65).
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Controlling the Sprint PCS Connection Manager Window

Expanding Sprint PCS Connection Manager

Sprint PCS Connection Manager has two views: expanded, and non-expanded.

Non-expanded view:

To expand Sprint PCS Connection Manager, click . Sprint PCS Connection 
Manager now also displays the amount of data transferred during the current 

connection, and (only when Disconnected) the lock state of the card (locked  or 

unlocked ).

To change back to non-expanded view, click .
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Minimizing Sprint PCS Connection Manager
To save space on your screen for other programs, you can minimize the Sprint PCS 
Connection Manager:

� Click  (in the upper right corner of Sprint PCS Connection Manager).

– or –

Click the Sprint PCS Connection Manager icon  in the system tray.

– or –

Right-click the system tray icon and select Close Sprint PCS Connection Manager.

You can use the system tray icon to monitor the connection state (page 38).

Restoring Sprint PCS Connection Manager
To restore Sprint PCS Connection Manager when it is minimized:

� Click the Sprint PCS Connection Manager icon  in the system tray. 

– or –

Right-click the system tray icon and select Open Sprint PCS Connection Manager.

Exiting Sprint PCS Connection Manager
To exit Sprint PCS Connection Manager:

� In Sprint PCS Connection Manager, click Menu > Exit, or click the  button,

– or –

Right-click the Sprint PCS Connection Manager icon  in the system tray and, 
from the shortcut menu, select Exit.

If a connection is in progress, a window is displayed asking whether you want to 
disconnect the call. To end the connection and close Sprint PCS Connection 
Manager, you must click Yes.

Sprint PCS Connection Manager exits, and the Sprint PCS Connection Manager 
icon disappears from the system tray.

Tip: You can set Sprint PCS Connection Manager to start minimized. (See “Start 
in system tray” on page 56.)

Tip: You can prevent Sprint PCS Connection Manager from minimizing by setting 
“Always on top” (page 56).
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Launching a Sprint PCS Vision Connection

To launch a Sprint PCSVision connection:

� In Sprint PCS Connection Manager, click GO. (If GO is unavailable, see “GO 
Button Is Unavailable” on page 75.)

When the connection is successfully established, the Sprint PCS Network welcome 
screen appears (unless you have turned off the display of the welcome screens; 
see “Always show Welcome screens” on page 58).

Sprint PCS Connection Manager displays “Connected” (page 37).

You can now use your web browser, perform data transfers, and so on.

To monitor the status of the connection, you can use the text (page 35) and icons 
(page 33) in Sprint PCS Connection Manager, and the icon in the system tray 
(page 38). You can also view the amount of data transferred (page 42).

Tip: You can also set the Sprint PCS Vision connection to launch automatically 
whenever available (see “GO automatically when ready” on page 58). If you 
also set Sprint PCS Connection Manager to launch automatically whenever 
Windows starts (see “Launch when Windows starts” on page 56), this can 
provide an “always-on” connection, as long as you have Sprint PCS Vision 
network coverage.
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Viewing the Amount of Data Transferred

To view the number of bytes sent/received during the current connection:

� If Sprint PCS Connection Manager is not expanded, click the  button.

The number of bytes sent/received during the current connection is displayed, in 
three significant digits (such as 581 kb, 1.23 Mb, 1.81 Mb).

Once you end the connection, the figures are set to zero.

To hide the part of Sprint PCS Connection Manager that displays this information, 

click the  button.

Ending a Connection

To end a connection:

� In Sprint PCS Connection Manager, click STOP.

If you exit Sprint PCS Connection Manager while a connection is in progress, a 
window is displayed asking whether you want to disconnect the call. By clicking 
Yes, you can end the connection and exit Sprint PCS Connection Manager. (See 
“Exiting Sprint PCS Connection Manager” on page 40.)

Note: Even though the number of bytes sent/received is displayed while the 
connection is running, this is not necessarily the actual amount of data 
being transmitted across the network. Do not use this information to estimate 
billing.
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Online Help

Sprint PCS Connection Manager includes extensive online help to provide 
operating hints and step by step instructions for getting the most from your 
Sprint PCS Connection Card.

You can access online help in several ways:

� Press <F1> in any window.

� From the Sprint PCS Connection Manager window, select MENU > Help.

� Right-click the system tray icon  and select Help.

� Click the Help button available in many windows.

The help file has a table of contents and an index.

Displaying Your Phone Number

You can view your phone number in the Device Info & Diagnostics window 
(Menu > Device Info & Diagnostics).

Security

When Disconnected, you can lock your Sprint PCS Connection Card so that others 
cannot use the card and account. A four-digit lock code is needed to unlock 
the card. 

You can set the Sprint PCS Connection Card to lock: 

� Whenever Sprint PCS Connection Manager is started (page 45), or 

� Immediately (without restarting Sprint PCS Connection Manager) - useful if you 
are lending your Sprint PCS Connection Card and PC or leaving it for a short 
time (page 44).

Initial Lock Code 

The initial lock code value is determined by your service provider. 

For service provider configurations that do not require account activation, a 
default lock code is set at the factory to a value determined by the service provider. 
For assistance, contact Sprint (page 27). 
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Configurations that use the Activation Wizard set the initial lock code to the last 
four digits of your account phone number whenever a new phone number is 
activated.

After activation, you can change the lock code (page 46) from the initial value to 
any four-digit code you choose. (See “Warning Regarding the Lock Code” below.)

Warning Regarding the Lock Code

If you lock the Sprint PCS Connection Card and forget the lock code, you will not be 
able to use the card until you receive assistance from Sprint.

Behavior When the Sprint PCS Connection Card Is Locked

When the Sprint PCS Connection Card is locked, you can:

� Unlock the card

When the card is locked, you cannot: 

� Make data connections (the GO button is unavailable)

� Run the Activation Wizard

Lock the Card

To lock the Sprint PCS Connection Card immediately: 

1. End any active connection. (You can lock the card only when Disconnected - 
page 36.)

2. If Sprint PCS Connection Manager is not expanded, click  to expand it.

3. Click the  icon.

4. In the Enter User Lock Code window, enter the lock code, and click OK.

When the card is locked, Sprint PCS Connection Manager displays “Card Locked”, 

and the lock icon is now . The GO button is unavailable.

Note: The security lock code is reset to the last four digits of the phone number 
whenever an account is activated. This may change a custom value you 
have set.

Warning: If you forget the lock code, you will not be able to use the card until you 
receive assistance from Sprint.

Tip: You can also set the card to be locked upon startup of Sprint PCS Connection 
Manager, as described next.
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Lock Upon Startup of Sprint PCS Connection Manager
To set the Sprint PCS Connection Card to lock as soon as Sprint PCS Connection Manager 
starts up: 

1. End any active connection. (You can lock the card only when Disconnected - 
page 36.)

2. If Sprint PCS Connection Manager is not expanded, click  to expand it.

3. Click the lock icon (  or , depending on the current lock status).

4. In the Enter User Lock Code window, enter the lock code, and select Relock card 
when program exits.

5. Click OK.

Unlock the Card

When locked, Sprint PCS Connection Manager displays “Card Locked”, and the lock 

icon is .

To unlock the card: 

1. If Sprint PCS Connection Manager is not expanded, click  to expand it.

2. Click the  icon.

3. In the Enter User Lock Code window, enter the lock code, and click OK.

When the card is unlocked, Sprint PCS Connection Manager no longer displays 

“Card Locked”, and the lock icon is .

Note: This setting takes effect only after you exit and restart Sprint PCS 
Connection Manager.
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Change the Lock Code

To change the lock code:

1. In the Sprint PCS Vision settings window, click User Lock Change.

The Change User Lock Code window is displayed:

2. Enter the current lock code.

3. Enter a new four-digit lock code.

4. Enter the new lock code for confirmation.

5. Click OK.

Accessing Links

For your convenience, Sprint PCS Connection Manager includes links to Sprint PCS 
products and services. To access these links:

1. In Sprint PCS Connection Manager, click Menu.

2. Select Links.

Warning:  If you forget the lock code, you will not be able to use the card until you 
receive assistance from Sprint.

Note: From the Links menu you cannot add or remove links. To do this, use your 
Web browser.
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Uninstalling the Sprint PCS Connection Manager Software

To remove the Sprint PCS Connection Manager software from your computer, use 
the Add/Remove Programs Utility built-in to your Windows Operating System.

1. Exit Sprint PCS Connection Manager (page 40).

2. Eject the Sprint PCS Connection Card. (See “Removing the Sprint PCS 
Connection Card” on page 21.)

3. Go to Start > Settings > Control Panel and select
Add/Remove Programs.

The Windows Add/Remove Programs utility will start. Be sure the Change or 
Remove Programs feature is selected (default).

4. From the list, select Sprint PCS Connection Manager, and click Remove.



48



Section 3B: Menu Options      49

Sec tion 3B

Menu Options

In This Section

� Sprint PCS Connection Manager Menu

� System Tray Menu

This chapter describes each menu option you may encounter while using your 
Sprint PCS Connection Card and the Sprint PCS Connection Manager software.
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Sprint PCS Connection Manager Menu

Clicking Menu or the  button, located in the upper left corner of Sprint PCS 
Connection Manager, displays the Sprint PCS Connection Manager menu.

The following table describes the menu options:

Note: Depending on your configuration and settings, not all menu options as 
described here might be shown or enabled.

Tip: You can also display the menu by positioning the cursor over the Menu text 

or  button and then pressing the spacebar or Enter key on your keyboard. 
To hide the menu, press Esc, or click outside of the menu.

Menu Item Description

Alert Log View a record of all alerts (for example, connection errors) that 
have been received while establishing and maintaining 
connections. 

See “Viewing Alerts” on page 63.

Connection 
History

View a record of connections established using your 
Sprint PCS Connection Card. (Unavailable if the Connection 
History is empty, or if Keep Connection History [page 56] is not 
selected.)

See “Viewing the Connection History” on page 62.
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Device Info & 
Diagnostics

View information about your Sprint PCS Connection Card, and 
run diagnostic tests. 

See “Running Diagnostics” on page 64.

Software 
Updates

Retrieve updates for Sprint PCS Connection Manager and your 
Sprint PCS Connection Card. 

See “Updating the Software” on page 66.

Links  Access links to Sprint PCS products and services. 

See “Accessing Links” on page 46.

Help Display the online Help, which has operating hints and step by 
step instructions for getting the most from your 
Sprint PCS Connection Card. 

See “Online Help” on page 43.

About 
Sprint PCS 
Connection 
Manager

 Display brief information about the Sprint PCS Connection 
Manager software. To close the window, click anywhere inside it. 

See “About Sprint PCS Connection Manager” on page 67.

Settings Change the settings for Sprint PCS Connection Manager. 
Contains submenu items:

� General: See “General Settings” on page 55.

� Sprint PCS Vision - Sierra Wireless: See “Sprint PCS Vision 
Settings” on page 57.

� Optimization: See “Optimization Settings” on page 59.

Exit  Exits Sprint PCS Connection Manager.

Menu Item Description
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System Tray Menu

When you right-click the system tray icon , a shortcut menu is displayed:

The following table describes the menu options:

Menu Item Description

Open/Close 
Sprint PCS 
Connection 
Manager

Minimizes Sprint PCS Connection Manager (Close), or restores 
(Open) if Sprint PCS Connection Manager is minimized.

Help Display the online Help.

About 
Sprint PCS 
Connection 
Manager

Display brief information about the Sprint PCS Connection 
Manager software. To close the window, click anywhere inside it.

Exit Exits Sprint PCS Connection Manager.
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Sec tion 3C

Changing the Settings of Sprint PCS Connection 
Manager

In This Section

� Settings Window

� General Settings

� Sprint PCS Vision Settings

� Optimization Settings

This chapter describes the windows from which you can change the settings for 
Sprint PCS Connection Manager.
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Settings Window

From the Settings window, you can specify the settings for Sprint PCS Connection 
Manager.

1. In Sprint PCS Connection Manager, click Menu.

2. Select Settings.

3. From the drop-down list, select one of the following categories of settings:

� General (general behavior of Sprint PCS Connection Manager)

� Sprint PCS Vision - Sierra Wireless (behavior of your Sprint PCS Vision 
connection)

� Optimization (bandwidth optimization level used by your Sprint PCS Vision 
connection)

4. Make the appropriate changes to the settings.

5. To change other settings, repeat steps 3 and 4.

6. Click OK.

Note: Changes to the setting Launch when Windows starts apply only after you 
restart Windows. Changes to the setting Start in system tray apply only after 
you exit and restart Sprint PCS Connection Manager.

Tip: You can also access the Settings window from the Connection History 
window: click File > Settings.
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General Settings

From the General option of the Settings window, you can specify settings that 
affect the general behavior of Sprint PCS Connection Manager.
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The following table describes the options:

Menu Item Description

Play sound 
effects

Play a clicking sound whenever an action is made in Sprint PCS 
Connection Manager.

Always on 
top

Keep Sprint PCS Connection Manager visible on your screen 
regardless of what applications are open.

Start in 
system tray

Have Sprint PCS Connection Manager start (minimized) in the 
system tray on startup. (See “Restoring Sprint PCS Connection 
Manager” on page 40.)

Keep 
Connection 
History

Have Sprint PCS Connection Manager keep a log of your data 
connections (page 62).

Launch when 
Windows 
starts

Have Sprint PCS Connection Manager start automatically (when 
Windows starts).

Tip: You can also set the Sprint PCS Vision connection to launch 
automatically whenever available (see “GO automatically when ready” 
on page 58). These two settings can provide an “always-on” 
connection, as long as you have Sprint PCS Vision network coverage.

Check for 
updates once 
per month

Have Sprint PCS Connection Manager automatically check for 
software updates (page 66).

Check Now Check for software updates immediately.

Note: During the software update, Sprint PCS Connection Manager 
will exit. Before you initiate the software update, finish any web 
browsing, data transfers, and so on.

Note: Changes to the setting Launch when Windows starts apply only after you 
restart Windows. Changes to the setting Start in system tray apply only after 
you exit and restart Sprint PCS Connection Manager.
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Sprint PCS Vision Settings

From the Sprint PCS Vision option of the Settings window, you can change the 
behavior of your Sprint PCS Vision connection.
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The following table describes the options:

Menu Item Description

Always show 
Welcome 
screens

Display a welcome screen upon a successful connection to the 
Sprint PCS Vision network.

GO 
automatically 
when ready

Automatically connect to the Sprint PCS Network after 
Sprint PCS Connection Manager launches.

Tip: You can also set Sprint PCS Connection Manager to start 
automatically (see “Launch when Windows starts” on page 56). These 
two settings can provide an “always-on” connection, as long as you 
have Sprint PCS Vision network coverage.

Sprint Disallow roaming when Sprint coverage is unavailable. You will 
be able to connect only when Sprint coverage is available.

Automatic Allow roaming when Sprint coverage is unavailable.

Note: Roaming rates will apply.

Roam Only Allow only roaming.

Note: Roaming rates will apply.

Activation 
Wizard

Used only when activating a Sprint PCS Connection Card, or 
when changing your card's phone number. See page 24.

User Lock 
Change

Change the security lock code of the Sprint PCS Connection Card 
(page 46).
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Optimization Settings

The Sprint PCS Connection Card supports bandwidth optimization – a 
combination of data compression, TCP/IP optimization and caching. When the 
related software is installed, the Sprint PCS Connection Card uses bandwidth 
optimization whenever possible (subject to network availability); when 

optimization is in use, the  icon is displayed in Sprint PCS Connection Manager.

The improvement in your perceived system speed depends on the nature of your 
application. Limitations to bandwidth optimization include minimal 
improvements with email applications (page 71).

From the Optimization option of the Settings window, you can set the bandwidth 
optimization level used by your Sprint PCS Vision connection.

To enable optimization:

� Select Bandwidth Optimization On.

Note: This window is available only if the optimization client was installed (page 17).
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To adjust the level of optimization:

� Use the slider (under Image Compression).

� For increased system speed, move the slider towards Fastest. This may 
result in a lower quality of graphics.

� For the highest quality of graphics, move the slider towards Highest Quality. 
This may result in a lower system speed.

Do not change the Protocol Compression settings, unless you are very familiar with 
how these protocols work, or a Sprint representative instructs you to change them.
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Sec tion 3D

Tools

In This Section

� Viewing the Connection History

� Viewing Alerts

� Running Diagnostics

� Updating the Software

� About Sprint PCS Connection Manager

This chapter describes various features you can use, to view information about the 
Sprint PCS Connection Card and the Sprint PCS Connection Manager software.
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Viewing the Connection History

Connection History displays a record of connections established using your 
Sprint PCS Connection Card. You can sort records by connection name, to easily 
distinguish between personal and business usage.

From this window you can also access the Settings window (page 54) (File > 
Settings).

To view the Connection History:

1. In Sprint PCS Connection Manager, click Menu.

2. Select Connection History.

To sort the entries:

� Click the button that contains the title of the column you want to sort by (you 
can reverse the sort order by clicking the button again).

– or –

Click an option under the Sort menu.

To export the entries to a text file:

1. Select File > Export.

2. Specify a file name and path.

3. Click Save.

To copy one or more entry:

1. Select the entries (click a single entry, or use Ctrl-click or Shift-click to select 
multiple entries; to select all entries, use Edit > Select All).

2. Select Edit > Copy.

3. Paste the entries (for example, into a text file or email).

Note: For connections to be recorded, Keep Connection History must be enabled 
(page 56).
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To delete all entries:

� Click the Clear button.

To delete one or more entry:

1. Select the entries (click a single entry, or use Ctrl-click or Shift-click to select 
multiple entries).

2. Select Edit > Delete.

Viewing Alerts

The Alert Log displays a record of all alerts (for example, connection errors) that 
have been received while establishing and maintaining connections. You can use 
the Alert Log to help isolate and resolve connection issues.

To view the Alert Log:

1. In Sprint PCS Connection Manager, click Menu.

2. Select Alert Log. (This menu option is unavailable, if the alert log is empty.)

To sort the entries:

� Click the button that contains the title of the column you want to sort by (you 
can reverse the sort order, by clicking the button again) 

– or –

Click an option under the Sort menu.

To export the entries to a text file:

1. Select File > Export.

2. Specify a file name and path.

3. Click Save.
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To copy one or more entry:

1. Select the entries (click a single entry, or use Ctrl-click or Shift-click to select 
multiple entries; to select all entries, use Edit > Select All).

2. Select Edit > Copy.

3. Paste the entries (for example, into a text file or email).

To delete all entries:

� Click the Clear button.

To delete one or more entry:

1. Select the entries (click a single entry, or use Ctrl-click or Shift-click to select 
multiple entries).

2. Select Edit > Delete.

Running Diagnostics

To identify problems connecting to the Sprint PCS Network, use the Device 
Info & Diagnostics window. Device Info & Diagnostics evaluates issues with your 
USB port, port configuration, network signal strength, the Sprint PCS Network, 
Sprint PCS Connection Manager, and more. Once the program runs a diagnostics 
check, it recommends solutions.

The program also displays information such as your phone number.

Results of the diagnostics can be shared with a Sprint Customer Service Specialist, 
to assist that person with troubleshooting.

To access the Device Info & Diagnostics window:

1. Ensure the Sprint PCS Connection Card is inserted.

2. In Sprint PCS Connection Manager, click Menu.

3. Select Device Info & Diagnostics.
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The tests automatically execute when the window opens.

From the Device Info & Diagnostics window, you can view system information 
(page 66), and save the system information to an RTF file.

From the Device Info & Diagnostics window, you can also update parameters in 
your Sprint PCS Connection Card:

� Click Update Data Profile. (If this button is not displayed, eject and re-insert 
the card.)
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Displaying System Information

The System Information window displays:

� System Parameters: Information about your computer hardware and software

� Installed Files: Files related to Sprint PCS Connection Manager

� Device Info & Diagnostics: Information about the Sprint PCS Connection Card 
(including its phone number), and results of various tests

To display system information:

1. Select Menu > Device Info & Diagnostics.

2. In the Device Info & Diagnostics window, click System Information.

To save the information to a file (for example, if you are requested to send the report to 
your service provider representative):

1. In the System Information window, click Create Report.

2. Specify a file name and path.

3. Click Save.

Updating the Software

From time to time, Sprint may release updates for Sprint PCS Connection Manager 
and your Sprint PCS Connection Card. These updates might add features or 
improve network performance.

To update the software:

1. Ensure you have a network connection.

2. In Sprint PCS Connection Manager, click Menu. Select Software Updates. 

– or –

From the General option of the Settings window (page 54), click Check Now.

You can also set the software to automatically check for updates once a month:

1. In Sprint PCS Connection Manager, click Menu. Select Settings.

2. Select Check for updates once per month.

Note: During the software update, Sprint PCS Connection Manager will exit. 
Before you initiate the software update, finish any web browsing, data 
transfers, and so on.
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About Sprint PCS Connection Manager

The About Sprint PCS Connection Manager window displays information about 
the Sprint PCS Connection Manager software.

To display this window:

� In Sprint PCS Connection Manager, click Menu, then About Sprint PCS 
Connection Manager. 

– or –

Right-click the Sprint PCS Connection Manager icon  in the system tray and, 
from the shortcut menu, select About Sprint PCS Connection Manager.

To close this window, click anywhere inside it.

Tip: To display more information, you can run diagnostics (page 64).
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Sec tion 3E

Frequently Asked Questions

In This Section

� What is Sprint PCS Connection Manager?

� If the connection is “always on,” am I always being billed?

� How fast is the connection with Sprint PCS Connection Manager?

� Can I connect to a dial-up account like AOL or EarthLink?

� Once I connect to the Nationwide Sprint PCS Network, how do I access my corporate 
network through a VPN?

� How can I optimize my settings to achieve the fastest speeds and conserve data 
when accessing my corporate network?

� Why won't my laptop go into hibernation mode when using my 
Sprint PCS Connection Card?
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What is Sprint PCS Connection Manager?

Sprint PCS Connection Manager is software that lets you connect to the Sprint PCS 
Vision Network. Sprint PCS Connection Manager takes advantage of the increased 
data speeds offered by the Nationwide Sprint PCS Network.

If the connection is “always on,” am I always being billed?

No. The connection to the network goes dormant after a period of inactivity, but 
the connection can be re-established faster than having to reconnect. Billing 
occurs only when data is passed across the network.

How fast is the connection with Sprint PCS Connection 
Manager?

The Sprint PCS Network allows you to connect to the Internet at speeds of up to 
2.4 Mbps (1xEV-DO) or 144 kbps (1X). Average connection speeds are between 
300 and 500 kbps for 1xEV-DO, and between 50 kbps and 70 kbps for 1X. This is 
faster than a dial-up connection. Bandwidth optimization on the Nationwide 
Sprint PCS Network (page 59) provides increased data throughput for certain 
applications and protocols.

Can I connect to a dial-up account like AOL or EarthLink?

No. The software does not support dial-up connections.

Once I connect to the Nationwide Sprint PCS Network, how 
do I access my corporate network through a VPN?

Once you complete a wireless connection, you may need to launch an extranet 
client provided by your company and supply the appropriate username and 
password to gain access. For support, contact your company helpdesk.
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How can I optimize my settings to achieve the fastest 
speeds and conserve data when accessing my corporate 
network?

Depending on your corporate email client, you can optimize your settings by 
doing the following:

� Work in “offline” mode, and connect only when you need to send or receive 
e-mail.

� Remove the Preview Pane, or use the AutoPreview for headers only.

� Save attachments to a desktop folder and then open from that folder, rather 
than opening the attachment directly from the message.

For more information, access the Microsoft whitepaper at:
www.microsoft.com/office/outlook/evaluation/perform.doc.

See also Optimization Settings (page 59).

Why won't my laptop go into hibernation mode when 
using my Sprint PCS Connection Card?

If you're using Windows® 2000, you need to upgrade to Service Pack 4 from 
www.microsoft.com.

http://www.microsoft.com/office/outlook/evaluation/perform.doc
http://www.microsoft.com
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Sec tion 3F

Troubleshooting Tips

In This Section

� Problems, Causes, and Solutions

� GO Button Is Unavailable

� Not In Service

� Cannot Connect To the Sprint PCS Vision network

� Could Not Prepare Data Services

� Unable To Prepare Data Services

� Sprint PCS Connection Manager Stopped Working After Upgrading Windows

This section helps you diagnose and solve common problems you may experience 
while using your Sprint PCS Connection Card and the Sprint PCS Connection 
Manager software.
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Problems, Causes, and Solutions

When properly installed, the Sprint PCS Connection Card is a highly reliable 
product.

Most problems are caused by one of these issues:

� System resources required by the card are being used by other devices. See 
“System Requirements” on page 8.

� Network coverage is not available (either because you are outside the 
Nationwide Sprint PCS Network or because of an account or network problem).

� The driver did not install properly, due to a PC Card issue with your notebook 
computer.

Tips when troubleshooting problems with your Sprint PCS Connection Card and 
software:

� Ensure your card is inserted, and not locked (page 44).

� To determine the connection status, use the icons in the system tray (page 38), 
and icons and messages in Sprint PCS Connection Manager (page 33 and 
page 35).

� The alert log might indicate the nature of the problem (page 63).

� Run diagnostic tools supplied with Sprint PCS Connection Manager (page 64).

� Check the Frequently Asked Questions (page 69).

� Use the resources listed in Section 2D (page 27).

� Has Sprint PCS Connection Manager stopped working after you've upgraded to 
a different version of Windows (page 76)?

If, after reading this section, you are unable to resolve a problem, please visit 
www.sprint.com or contact Sprint Customer Service (see “Getting Help” on 
page 27).

http://www.sprint.com
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GO Button Is Unavailable

Ensure the Sprint PCS Connection Card is inserted and not locked (page 44).

Not In Service

If Sprint PCS Connection Manager displays “Not in service,” try one of the 
following: 

� Ensure the card is properly inserted into your computer.

� Try re-orienting the antenna.

� If you are inside a building or near a structure that may be blocking the signal, 
change the position or location of your computer.

� Ensure you are within the Sprint PCS Vision network coverage area.

� Check with Sprint — a network or account problem may be preventing the 
Sprint PCS Connection Card from obtaining service.

Cannot Connect To the Sprint PCS Vision network

If, when trying to establish a Sprint PCS Vision connection, the connection gets 
dropped as soon as it is established: 

1. Select:

Windows XP: Start > Control Panel > Network Connections

Windows 2000: Start > Settings > Control Panel > Network and Dial-Up 
Connections

2. Right-click Sprint PCS Vision - Sierra Wireless, and select Properties.

3. Select the Networking tab.

4. Select Settings.

5. Ensure that “Enable LCP Extensions” and “Negotiate multi-link for single link 
connections” are not selected. 

6. Click OK.

Could Not Prepare Data Services 

See Unable To Prepare Data Services on page 76.



76 Section 3F: Troubleshooting Tips

Unable To Prepare Data Services

The Sprint PCS Connection Card was unable to access the IOTA server to obtain 
data account parameters for you. This may be due to poor signal strength or the 
IOTA server is not responding.

� Confirm you have sufficient signal strength. Try the actions listed for “Not In 
Service” (page 75).

� Contact Sprint for assistance (page 27).

This message may indicate that your system does not support 128-bit encryption 
for high-security access to data provisioning. You will not be able to complete the 
activation of data services until you upgrade your system's security (see “High 
Encryption Requirements” on page 9).

Sprint PCS Connection Manager Stopped Working After 
Upgrading Windows

If you upgrade to a different version of Windows, Sprint PCS Connection Manager 
will not work.

Before you upgrade Windows, or if you've upgraded Windows and Sprint 
PCS Connection Manager stopped working:

1. Uninstall Sprint PCS Connection Manager (page 47).

2. Upgrade Windows.

3. Reinstall Sprint PCS Connection Manager (page 15).

Note: The message may appear as “Could not prepare data services. Please contact...”

Note: After the following steps, any changes you made to Sprint PCS Connection 
Manager settings will be lost; you will have to re-apply the changes.
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Sec tion 4A

Technical Specifications

In This Section

� LED Operation

� Radio Frequency and Electrical Specifications

� Software Specifications

� Environmental Specifications

� Mechanical Specifications

This section describes the LED and various specifications of your Sprint PCS 
Connection Card.
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LED Operation

The AirCard 580 has a single red/green LED on the antenna end of the card. The 
LED operates as follows:

LED Behavior Indicates

Red, blinking slowly The Sprint PCS Connection Card is powering up, or 
no service is available. See “Not In Service” on 
page 75.

Green, blinking 
slowly

The Sprint PCS Connection Card has acquired a 
channel on the CDMA network and is in idle mode 
(no active data session is in progress).

Green, blinking 
rapidly

An active data session is in progress.

Solid red An error has occurred. Eject the Sprint PCS 
Connection Card (page 21) and reinsert it.
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Radio Frequency and Electrical Specifications

Approvals Compliant with:

IS-2000 Release 1.0 (CDMA (1X), IS-707-A Data, IS-856 
(CDMA 1xEV-DO), IS-866, CDMA Developers Group

FCC (ID: PNF-PC3220P)

Industry Canada

Voltage +3.3 Vdc from PCMCIA Slot

Current Maximum:950 mA

Typical data call current (talk mode):

370 mA (1X)

470 mA (1xEV-DO)

Standby: 110 mA (1xEV-DO/IS2000 hybrid mode)

Transmitter 
power

200 mW (+23 dBm)

Transmit PCS: 1805 to 1870 MHz

Cellular: 824 to 849 MHz

Receive PCS: 1715 to 1780 MHz

Cellular: 868 to 894 MHz

Channel 
spacing

1.25 MHz

Frequency 
stability

±150 Hz
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Software Specifications

CDMA 
specification

IS - 2000 Release 0

Data service IS - 707A

SMS (IS-637) Not supported

FAX Not supported

IOTA Supported

OTASP (IS-683A, 
IS-683B, IS-683C)

Supported

OTAPA Supported

PRL (preferred 
roaming list)

Supported

Authentication Supported

Voice Not supported

NAM Single

E911 & Position 
Location

Not supported

TTY/Accessibility Not supported

Mobile IP Supported
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Environmental Specifications

Mechanical Specifications

Operating 
temperature

-20 to +60°C (ambient, outside PCMCIA enclosure)

Storage 
temperature

-30 to +65°C

Humidity 95%, non-condensing

Vibration Per PCMCIA specification

Drop 100 cm onto vinyl covered concrete 

Dimensions
(W x L x H)

54 mm x 116.8 mm x 11 mm

(Height of PC Card slot portion: 5mm)

Power button Not supported

Headset jack Not supported

LED Red/green
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Sec tion 4B

Regulatory Information

In This Section

� Regulatory Notices

� Patents

� Trademarks

� Copyright

� Limitation of Liability

� Additional Information and Updates

This section contains important regulatory notices about your 
Sprint PCS Connection Card, and also patent and other information.



86 Section 4B: Regulatory Information

Regulatory Notices

This device is compliant with Parts 15 and 24 of the FCC Rules. This PC Card has 
been tested with the typical laptop computer with the side loading PCMCIA bay. 
This PC card must not be co-located or operated in conjunction with any other 
antenna or transmitter. Use of this device in any other configuration may exceed 
the FCC RF Exposure compliance limit. Operation of this device is subject to the 
following two conditions:

1. This device may not cause harmful interference, and

2. This device must accept any interference received, including interference that 
may cause undesirable operations.

FCC guidelines stipulate that the antenna should be more than 2.5 cm (1") from 
by-standers and 1.0 cm (0.39") from the user. When in use, the antenna should be 
fully extended upward at a 90 degree angle.

The highest reported SAR values of the Sprint PCS Connection Card by Sierra 
Wireless (AirCard 580) are:

1. Separation distance of 2.5 cm (1") to nearby persons (0.85 W/kg).

2. Direct contact to user's lap with Sprint PCS Connection Card inserted into the 
bottom PC Card slot of the laptop computer with antenna in the stowed 
(down) position (0.782 W/kg).

FCC ID: PNF-PC3220P

CAUTION: Unauthorized modifications or changes not expressly approved by 
Sprint Communications Company L.P. could void compliance with regulatory rules 
and thereby your authority to use this equipment.

WARNING (EMI) - United States FCC Information: This equipment has been tested 
and found to comply with the limits pursuant to Part 15 & 24 of the FCC Rules. 
These limits are designed to provide reasonable protection against harmful 
interference in an appropriate installation.

This equipment generates, uses, and can radiate radio frequency energy and, if 
not installed and used in accordance with the instructions, may cause harmful 
interference to radio communication. However, there is no guarantee that 
interference will not occur in a particular installation. If this equipment does 
cause harmful interference to radio or television reception, which can be 
determined by turning the equipment off and on, the user is encouraged to try to 
correct the interference by one or more of the following measures:
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� Reorient or relocate the receiving antenna

� Increase the separation between the equipment and receiver

� Connect the equipment into an outlet on a circuit different from that to which 
the receiver is connected

� Consult the dealer or an experienced radio/TV technician for help

WARNING (EMI) - Canada: This digital apparatus does not exceed the Class B limits 
for radio noise emissions from digital apparatus as set out in the interference 
causing equipment standard entitled “Digital Apparatus,” ICES-003 of the 
Department of Communications.

Cet appareil numérique respecte les limites de bruits radioélectriques applicables 
aux appareils numériques de Classe B prescrites dans la norme sur le matériel 
brouilleur: “Appareils Numériques,” NMB-003 édictée par le ministre des 
Communications.

If you have purchased this product under a United States Government contract, it 
shall be subject to restrictions as set forth in subparagraph (c)(1)(ii) of Defense 
Federal Acquisitions Regulations (DFARs) Section 252.227-7013 for Department of 
Defense contracts, and as set forth in Federal Acquisitions Regulations (FARs) 
Section 52.227-19 for civilian agency contracts or any successor regulations. If 
further government regulations apply, it is your responsibility to ensure 
compliance with such regulations.
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Patents

Portions of this product are covered by some or all of the following US patents:

5,515,013 5,629,960 5,682,602 5,845,216 5,847,553

5,878,234 5,890,057 5,929,815 6,169,884 6,191,741 

6,199,168 6,339,405 6,359,591 6,400,336 6,516,204 

6,561,851 6,643,501 6,653,979 6,697,030 6,785,830 

6,845,249 6,847,830 6,876,697 6,879,585 D442,170 

D459,303 

and other patents pending.

Licensed by QUALCOMM Incorporated under one or more of 
the following United States patents and/or their counterparts 
in other nations:

4901307 5056109 5101501 5109390 5228054

5267261 5267262 5337338 5414796 5416797

5490165 5504773 5506865 5511073 5535239

5544196 5568483 5600754 5657420 5659569

5710784 5778338

Manufactured or sold by Sierra Wireless Inc., its Affiliates, or its Licensees under 
one or more patents licensed from InterDigital Group.
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Trademarks

Sprint, the “Going Forward” logo and other trademarks are trademarks of 
Sprint Nextel. 

AirCard® and “Heart of the Wireless Machine”® are registered trademarks of Sierra 
Wireless.

Sierra Wireless, the Sierra Wireless logo, the red wave design, and the red-tipped 
antenna are trademarks of Sierra Wireless.

Windows® is a registered trademark of Microsoft Corporation.

Qualcomm® is a registered trademark of Qualcomm Incorporated.

InstallShield® is a registered trademark and service mark of InstallShield 
Corporation.

All other trademarks are property of their respective owners.

Copyright

© 2005 Sprint Nextel. All rights reserved. No reproduction in whole or in part 
without prior written approval. Sprint, the “Going Forward” logo, the NEXTEL 
name and logo, and all other trademarks are trademarks of Sprint Nextel.

©2005 Sierra Wireless. All rights reserved.

Document 2130612 Revision 1.0
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Limitation of Liability

The information in this manual is subject to change without notice and does not 
represent a commitment on the part of Sierra Wireless. SIERRA WIRELESS AND ITS 
AFFILIATES SPECIFICALLY DISCLAIM LIABILITY FOR ANY AND ALL DIRECT, INDIRECT, 
SPECIAL, GENERAL, INCIDENTAL, CONSEQUENTIAL, PUNITIVE OR EXEMPLARY 
DAMAGES INCLUDING, BUT NOT LIMITED TO, LOSS OF PROFITS OR REVENUE OR 
ANTICIPATED PROFITS OR REVENUE ARISING OUT OF THE USE OR INABILITY TO 
USE ANY SIERRA WIRELESS PRODUCT, EVEN IF SIERRA WIRELESS AND/OR ITS 
AFFILIATES HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES OR THEY 
ARE FORESEEABLE OR FOR CLAIMS BY ANY THIRD PARTY.

Notwithstanding the foregoing, in no event shall Sierra Wireless and/or its 
affiliates aggregate liability arising under or in connection with the Sierra Wireless 
product, regardless of the number of events, occurrences, or claims giving rise to 
liability, be in excess of the price paid by the purchaser for the Sierra Wireless 
product.

Additional Information and Updates

For up-to-date product descriptions, documentation, application notes, firmware 
upgrades, troubleshooting tips, and press releases, visit:

www.sierrawireless.com

http://www.sierrawireless.com
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Sec tion 5A

Safety and Notices

In This Section

� Important Notice

� Safety and Hazards

� Care and Maintenance

This section describes important guidelines regarding your Sprint PCS 
Connection Card.



94 Section 5A: Safety and Notices

Important Notice

Because of the nature of wireless communications, transmission and reception of 
data can never be guaranteed. Data may be delayed, corrupted (i.e., have errors) or 
be totally lost. Although significant delays or losses of data are rare when wireless 
devices such as the Sprint PCS Connection Card by Sierra Wireless (AirCard 580) 
CDMA modem are used in a normal manner with a well-constructed network, 
they should not be used in situations where failure to transmit or receive data 
could result in damage of any kind to the user or any other party, including but not 
limited to personal injury, death, or loss of property. SPRINT SPECTRUM L.P. accepts 
no responsibility for damages of any kind resulting from delays or errors in data 
transmitted or received using the Sprint PCS Connection Card by Sierra Wireless 
(AirCard 580) CDMA modem, or for failure of the Sprint PCS Connection Card by 
Sierra Wireless (AirCard 580) to transmit or receive such data.

Safety and Hazards

Do not operate the Sprint PCS Connection Card by Sierra Wireless (AirCard 580) in 
areas where blasting is in progress, where explosive atmospheres may be present, 
near medical equipment, life support equipment, or any equipment which may be 
susceptible to any form of radio interference. In such areas, the Sprint PCS 
Connection Card by Sierra Wireless (AirCard 580) MUST BE POWERED OFF. It can 
transmit signals that could interfere with this equipment.

Do not operate the Sprint PCS Connection Card by Sierra Wireless (AirCard 580) in 
any aircraft, whether the aircraft is on the ground or in flight. In aircraft, the Sprint 
PCS Connection Card by Sierra Wireless (AirCard 580) MUST BE POWERED OFF. 
When operating, it can transmit signals that could interfere with various onboard 
systems.

The driver or operator of any vehicle should not operate the Sprint PCS Connection 
Card by Sierra Wireless (AirCard 580) while in control of a vehicle. Doing so will 
detract from the driver or operator's control and operation of that vehicle. In some 
jurisdictions, operating such communications devices while in control of a vehicle 
is an offense.

Care and Maintenance

See page 11.
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Sec tion 5B

Terms and Conditions

In This Section

� Terms and Conditions of Services

This section contains the terms and conditions of service for your 
Sprint PCS Connection Card.
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Terms and Conditions of Services

Effective September 1, 2005 

Thanks for choosing Sprint. These terms and conditions are part of your 
agreement with Sprint for PCS (CDMA) Services. Separate terms apply for any 
iDEN products or services.

Please note these terms may not be the most current version. You can get a 
current version of the terms on our website at www.sprint.com or by requesting a 
copy from us at 1-888-211-4PCS. 

A para solicitar esta literatura en español, por favor contactar a 1-888-211-
4PCS(4727).

General. This agreement (“Agreement”) covers the terms on which we agree to 
provide and you agree to accept any service or product we make available to you, 
including your wireless services, wireless devices, etc. (collectively “Services”). You 
accept this Agreement when you do any of the following: (a) provide your written 
or electronic signature; (b) accept through an oral or electronic statement; (c) 
attempt to or in any way use any of the Services; (d) pay for any Services; or (e) 
open any materials or package that says you are accepting when you open it. The 
Agreement includes the terms in this document together with the terms 
associated with the Services you select (as described in our marketing materials, 
e.g., service plan brochures, or on our website). You represent that you are at least 
18 years old. In this document, we use the words “we,” “us,” “our” or “Sprint” to 
refer to Sprint Spectrum L.P. and its affiliates doing business as Sprint PCS.

Agreement. We may change the Agreement at any time with notice. Any changes 
to the Agreement are effective when we publish them. If you use our Services or 
make any payment to us on or after the effective date of the changes, you accept 
the changes. If we change a material term of the Agreement and that change has 
a material adverse effect on you, you may terminate the Agreement without an 
Early Termination Fee by calling 1-888-567-5528 within 30 days after the changes 
go into effect. You understand and agree that taxes, Universal Service fees and 
other charges imposed by the government or based on government calculations 
may increase or decrease on a monthly basis, and that this paragraph does not 
apply to any increases in such taxes, Universal Service fees or other charges.

Activating Service. Before activation, we may check your credit and verify your 
identity. You must have and maintain satisfactory credit to receive and continue to 

http://www.sprint.com
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receive Services. We may charge a nonrefundable activation fee, deposit, 
prepayment or other fee to establish or maintain Services.

Term Commitments. Unless we specifically tell you otherwise, our service plans 
require that you maintain service for a minimum term (“Term Service Plan”), 
usually 

1 or 2 years. After satisfying this minimum term, your service plan will continue on 
a month-to-month basis unless you have agreed to extend the term for additional 
period(s). Certain service, promotional or product offers may require that you 
agree to or extend a Term Service Plan. As discussed below, we may charge you an 
Early Termination Fee if you deactivate a Term Service Plan before the end of the 
term. 

Using Services. You agree to not use our Services in an unlawful, fraudulent or 
abusive manner. You may not resell or lease Services to anyone. Sprint is not 
responsible for any opinions, advice, statements, services applications or other 
information provided by third parties and accessible through our various Services, 
including the internet. Neither Sprint, its vendors or licensors guarantees the 
accuracy, completeness or usefulness of information that is obtained through 
these Services. You are responsible for evaluating such content. 

You are also responsible for any use of our Services through any wireless device on 
your account including, but not limited to, use by children or minors. We strongly 
recommend that you closely monitor any such usage. 

Changing Services. Changes to Services will generally be effective at the start of 
your next full invoicing cycle. In certain instances, the changes may take place 
sooner, in which case your invoice will reflect pro-rated charges. Certain changes 
may be conditioned upon payment of an Early Termination Fee or certain other 
charges. 

 Termination of Services. Consistent with this Agreement: (a) we may terminate 
Services at any time with notice to you and, in certain instances, without notice; 
and (b) you may terminate Services at any time with prior notice to us. Except as 
otherwise provided in this Agreement, IF YOU TERMINATE YOUR TERM SERVICE 
PLAN EARLY, OR WE DO SO FOR GOOD CAUSE, YOU WILL BE REQUIRED TO PAY THE 
APPLICABLE EARLY TERMINATION FEE ASSOCIATED WITH YOUR SERVICES. We will 
not charge an Early Termination Fee for deactivations consistent with our Return 
Policy or for service plans being provided on a month-to-month basis. If any 
Services are terminated before the end of your current invoicing cycle, we will not 
prorate charges to the date of termination, and you will not receive a credit or 
refund for any unused Services. 
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Wireless Devices, Numbers & E-mail Addresses. We did not manufacture your 
wireless device and we are not responsible for any defects or for the acts or 
omissions of the manufacturer. The only warranties on your device are any limited 
warranties extended by the manufacturer directly to you or passed on to you 
through us. Your device may not accept Services directly from any other carrier. 
You do not have any rights to any number, e-mail address or other identifier we 
may assign to your device or account; you may not modify, change or transfer any 
of these except as we allow or as allowed for by law. In certain instances, you may 
transfer your number from another carrier to us, or from us to another carrier. We 
do not guarantee that transfers to or from us will be successful. If you transfer 
your number away from us, the terms of this Agreement (e.g., Early Termination 
Fee, etc.) still apply. If a transfer to Sprint is not successful, you will be responsible 
for any discounts provided to you with the purchase of your device. See our 
printed in-store materials or visit www.sprint.com for additional important 
information on number transfers.

Coverage. Available coverage areas for Services are generally identified in our 
mapping brochures and at www.sprint.com. This may include coverage on our 
digital network (the “Nationwide Sprint PCS Network”) as well as coverage we 
make available to you through agreements with other carriers (“off network” or 
“roaming” coverage). 

All coverage maps are high level representations of outdoor coverage and there 
are gaps in coverage within areas shown as covered on the maps. Coverage is not 
available everywhere, nor can we guarantee you will receive coverage at all times, 
or without interruptions or delays (e.g., dropped calls, blocked calls, etc.) in the 
coverage areas we identify. Actual coverage and quality of Services may be 
affected by conditions within or beyond our control, including network problems, 
software, signal strength, your equipment, structures (including buildings in 
which you may be located), atmospheric, geographic, or topographic conditions. 

Roaming Coverage. You are roaming anytime your phone indicates that you are 
roaming. Roaming coverage is only available with certain devices and, unless 
included as part of your Services, will result in additional charges. Roaming calls 
placed “manually” (through an operator or with a credit card) will always incur 
separate and additional charges. Depending on your phone settings, you may 
automatically roam if there is a gap or interruption in coverage within the 
Nationwide Sprint PCS Network coverage area and roaming coverage areas. See 
your phone guide for how to adjust phone settings. Certain features and services 
may not be available in roaming coverage areas (including PCS Vision, voicemail, 
call waiting, call forwarding, etc.).

http://www.sprint.com
http://www.sprint.com
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Charges. Carefully review the terms of your Services. You will be assessed charges 
based on the terms of your Services including, without limitation, monthly 
recurring charges and charges based on actual usage (e.g., charges for long 
distance, roaming, call forwarding, directory assistance, etc.). Airtime and other 
time based usage charges are calculated from when your device first initiates 
contact with a network until the network connection is broken, whether or not 
you were actually successful in connecting to the intended destination. However, 
you will not be charged for voice calls that ring and do not pick up, or if you get a 
busy signal. For voice calls received by your device, you are charged from the time 
shortly before the phone starts ringing until the call is terminated. You are 
charged for an entire voice call based on the time period in which the call is 
initiated. Partial minutes of use are rounded up to the next minute. 

Sprint PCS Vision Charges. Vision usage is measured in bytes, not in minutes. Bytes 
are rounded up to kilobytes. Usage rounding occurs at the top of each clock hour 
while in a session and at the end of each session and is then charged to you based 
on the terms of your Services. Depending on your Services, usage may be charged 
against an allowance or on a fixed price per kilobyte. Usage charges may be 
rounded up to the next cent at monthly or other intervals. In certain instances, you 
may not know that your session has not ended. As long as your device is 
connected to our network, you will incur data usage charges. You will be charged 
for all data directed to the internet address (or “IP address”) assigned to your 
device, regardless of who initiates the activity or whether your device actually 
receives the data. This includes, but is not limited to, the amount of data 
associated with the particular information/item (e.g., game, ringer, email, etc.), 
additional data used in accessing, transporting and routing this information/item 
on our network, data from partial or interrupted downloads, re-sent data, and 
data associated with unsuccessful attempts to reach websites or use applications. 
Based on these and a number of other factors (e.g., the specific application, 
network performance, etc.) data used and charged to you will vary widely, even for 
the same activity. Estimates of data usage - for example, the size of downloadable 
files - will not be accurate or a reliable predictor of actual usage. Your invoice will 
not separately identify the number of kilobytes attributable to your use of specific 
sites, sessions or services. 

Taxes and Surcharges. We invoice you for taxes, fees and other charges levied by or 
remitted directly to federal, state, local or foreign governments including, without 
limitation, sales, gross receipts, Universal Service, use, and excise taxes. If you claim 
any tax exemption, you must provide us with a valid tax-exempt document. Tax 
exemptions are not applied retroactively. We also invoice you for surcharges that 



100 Section 5B: Terms and Conditions

we collect and keep to pay for the costs of complying with government programs 
such as number pooling and portability, and Enhanced 911 service; these charges 
are not the taxes nor government imposed assessments. 

Invoicing & Payment. Invoicing cycles and dates may change from time to time. 
Monthly recurring and related charges for Services are generally invoiced one 
invoicing cycle in advance. Other charges are invoiced soon after they are incurred. 
Most usage is generally applied to the invoicing cycle in which they are incurred, 
but in some instances may be applied to subsequent invoicing cycles. You are 
responsible for all charges associated with any device activated on your account, 
regardless of who used the device. You must pay all charges by the due date on 
the invoice. Past due amounts accrue late charges until paid at the rate of 5% per 
month or at the highest rate allowed by law and may result in immediate 
suspension of your account. If you agree to any auto-payment option through 
banking or credit account, we may initiate payment from the account for all 
amounts we invoice you without additional authorization or notice. Based on your 
credit or payment history, we may require certain forms of guaranteed payment 
as a condition of maintaining Services. If we invoice you for amounts on behalf of 
a third-party, payments received are first applied to amounts due to us. You may 
be charged additional fees for certain methods of payment and for payments 
denied by a financial institution. Acceptance of payments (even if marked “paid in 
full”) does not waive our right to collect all amounts that you owe us. 

Disputed Charges. Disputes concerning any charges invoiced must be raised within 
60 days of the date of the invoice. You accept all charges not disputed in this time 
period. Disputes can only be made by calling or writing us as directed on your 
invoice.

Account Spending Limit & Deposits. We may impose an account spending limit 
(“ASL”) on any account without notice. We will notify you of an ASL based on your 
credit or payment history and may reduce the ASL at any time with prior notice. 
An ASL should not be relied on to manage usage on your account. We may 
suspend an account without prior notice when the account balance reaches the 
ASL, even if the account is not past due. Services can be restored upon payment of 
an amount that brings the account balance below the ASL and any past due 
amounts. If we require a deposit for you to establish or maintain an account, we 
will hold the deposit as partial guarantee of payment for Services. We may change 
the deposit amount at any time with notice for good reason. Except as we allow, a 
deposit may not be used to pay any invoice or delay payment. The deposit 
amount, the length of time we hold the deposit and changes to the deposit 
amount are determined based on your credit and payment history. The rate of 
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interest, if any, on the deposit is subject to change. We may mix deposits with our 
other funds. If your account is terminated for any reason, we may without notice 
apply your deposit to any outstanding charges. We may send any remaining 
deposit amounts to your last known address within 75 days after account 
termination. If the funds are returned to us, you may claim these funds for one 
year from the date of return. Any money held during this one-year period will not 
accrue interest for your benefit and are subject to a servicing fee charged against 
the balance. You forfeit any portion of the money left after the one-year period.

Other Sprint PCS Vision Terms. You will not receive voice calls while using Vision. 
Vision is not available for use with server devices or host computer applications, 
other systems that drive continuous heavy traffic or data sessions, or as 
substitutes for private lines or frame relay connections. Unlimited Vision plans/
options may not be used with Sprint PCS phones or smart phones being used as a 
modem in connection with other equipment (e.g., computers, etc.) through use of 
connection kits or other phone-to-computer/PDA accessories, or Bluetooth or 
other wireless technology. We may terminate services without notice for any 
misuse. You may have access to certain games, ringers, screen savers and other 
items on our Vision site (“Premium Services”) that are available for an additional 
charge. You will be billed for Premium Service purchases on your Sprint PCS invoice 
based on the charges as specified at purchase. Subject to the terms of the content 
purchased, we may delete premium and non-premium items downloaded to any 
storage areas we may provide, including any pictures, games and other content. 
We may limit the amount of Premium Services you may purchase in a specific 
timeframe (month, week, day, or other time period).

Voice Command. Calls to 911 or similar emergency numbers cannot be placed 
through the Voice Command feature. See our printed in-store materials or visit 
www.sprint.com for additional important information on this option.

Wireless Web. Wireless Web Services may be available depending on your device 
and Service plan/option. This is not a Vision service. Usage is calculated on 
minutes used and generally deducts from your Service plan minutes. See our 
printed in-store materials or visit www.sprint.com for additional important 
information on this option.

Lost or Stolen Equipment. If your device is lost or stolen, please notify us 
immediately by calling 1-888-211-4PCS. You are responsible for all charges 
incurred before you notify us of the loss or theft. You agree to cooperate 
reasonably with us in investigating suspected unlawful or fraudulent use.

http://www.sprint.com
http://www.sprint.com
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Messaging. You may incur charges in accessing, sending or receiving messages on 
your device. We may impose limits on the number of voicemail, text, email or 
other messages that can be retained through your account. Indicators of 
messages on your device, including mailbox icons, may not always provide an up 
to date indication of new messages and you may at times need to manually reset 
or clear your mailbox indicator. Legitimate messages may be interrupted by 
software aimed at prevention of SPAM or similar messages.

Caller ID. If you do not want people you call to receive the number assigned to your 
phone, call us at 1-888-211-4PCS for information about automatic Caller ID 
blocking. The number assigned to your phone can be blocked on a per-call basis by 
dialing *67 + Destination Number + TALK (or similar key). Caller ID blocking is not 
available when using Vision or Wireless Web services. 

TTY Access. A TTY (also known as TDD or Text Telephone) is a telecommunications 
device that allows people who are deaf or hard of hearing, or who have speech or 
language disabilities, to communicate by telephone. TTY doesn't work with all 
devices. If you have a TTY-capable device, it may not function effectively, or at all, 
when attempting 911 calls and should not be relied on for such calls.

Disclaimer of Warranties. WE MAKE NO REPRESEN-TATIONS OF WARRANTIES, 
EXPRESS OR IMPLIED, INCLUDING (TO THE EXTENT ALLOWED BY LAW) ANY 
IMPLIED WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR 
PURPOSE CONCERNING YOUR SERVICES OR WIRELESS DEVICE. WE DO NOT 
PROMISE UNINTERRUPTED OR ERROR-FREE SERVICES AND YOU AGREE TO HOLD 
US HARMLESS FOR ALL SUCH PROBLEMS. 

Limitation of Liability. Neither we nor our vendors, suppliers or licensors are liable 
for any damages arising out of or in connection with any: (a) act or omission by 
your, or another person or company; (b) providing or failing to provide Services, 
including deficiencies or problems with your wireless device, our network 
coverage or Services (e.g., dropped, blocked, interrupted calls/messages, etc.); (c) 
traffic or other accidents, or any health-related claims allegedly arising from the 
use of Services, any wireless devices or related accessories; (d) content or 
information accessed while using our Services, such as through the internet; (e) 
interruption or failure in accessing or attempting to access emergency services 
from your phone, including through 911, E911 or otherwise; or (f) events due to 
factors beyond our control, including acts of God (including, without limitation, 
weather-related phenomena, fire or earthquake), war, riot, strike, or orders of 
governmental authority. In the event we are found to be responsible to you for 
monetary damages relating to the Services (including wireless devices), you agree 
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that any such damages will not exceed the pro-rated monthly recurring charge for 
your Services during the affected period.

NO CONSEQUENTIAL OR OTHER DAMAGES. UNDER NO CIRCUMSTANCES ARE WE 
LIABLE FOR ANY INCIDENTAL, CONSEQUENTIAL, PUNITIVE OR SPECIAL DAMAGES 
OF ANY NATURE WHATSOEVER ARISING OUT OF OR IN CONNECTION WITH 
PROVIDING OR FAILING TO PROVIDE SERVICES, PHONES OR OTHER EQUIPMENT 
USED IN CONNECTION WITH THE SERVICES, INCLUDING, WITHOUT LIMITATION, 
LOST PROFITS, LOSS OF BUSINESS, OR COST OF REPLACEMENT PRODUCTS AND 
SERVICES. THIS SECTION SURVIVES TERMINATION OF THIS AGREEMENT.

MANDATORY ARBITRATION OF DISPUTES. INSTEAD OF SUING IN COURT, YOU AND 
SPRINT AGREE TO ARBITRATE ANY AND ALL CLAIMS, CONTROVERSIES OR DISPUTES 
AGAINST EACH OTHER ARISING OUT OF OR RELATING TO THIS AGREEMEN, 
INCLUDING, WITHOUT LIMITATION, THE SERVICES, ANY PHONES/EQUIPMENT, OR 
ADVERTISING, EVEN IF IT ARISES AFTER YOUR SERVICES HAVE TERMINATED, AND 
INCLUDING CLAIMS YOU MAY BRING AGAINST SPRINT'S EMPLOYEES, AGENTS, 
AFFILIATES OR OTHER REPRESENTATIVES, OR THAT SPRINT MAY BRING AGAINST 
YOU (“CLAIMS”). THE FEDERAL ARBITRATION ACT APPLIES TO THIS AGREEMENT 
AND ITS PROVISIONS, NOT STATE LAW, GOVERN ALL QUESTIONS OF WHETHER A 
CLAIM IS SUBJECT TO ARBITRATION. THIS PROVISION DOES NOT PREVENT EITHER 
YOU OR SPRINT FROM BRINGING APPROPRIATE CLAIMS IN SMALL CLAIMS COURT, 
BEFORE THE FEDERAL COMMUNICATIONS COMMISSION OR A STATE PUBLIC 
UTILITIES COMMISSION. 

YOU AND SPRINT FURTHER AGREE THAT NEITHER SPRINT NOR YOU WILL JOIN ANY 
CLAIM WITH THE CLAIM OF ANY OTHER PERSON OR ENTITY IN A LAWSUIT, 
ARBITRATION OR OTHER PROCEEDING; THAT NO CLAIM EITHER SPRINT OR YOU 
HAS AGAINST THE OTHER SHALL BE RESOLVED ON A CLASS-WIDE BASIS; AND THAT 
NEITHER SPRINT NOR YOU WILL ASSERT A CLAIM IN A REPRESENTATIVE CAPACITY 
ON BEHALF OF ANYONE ELSE. IF FOR ANY REASON THIS ARBITRATION PROVISION 
DOES NOT APPLY TO A CLAIM, WE AGREE TO WAIVE TRIAL BY JURY.

A single arbitrator engaged in the practice of law will conduct the arbitration. The 
arbitration will be filed with and the arbitrator will be selected according to the 
rules of either JAMS or the National Arbitration Forum (“NAF”), or, alternatively, as 
we may mutually agree. We agree to act in good faith in selecting an arbitrator. 
The arbitration will be conducted by and under the then-applicable rules of JAMS 
or NAF, wherever the arbitration is filed or, if the arbitrator is chosen by mutual 
agreement of the parties, the then-applicable rules of JAMS will apply unless the 
parties agree otherwise. All expedited procedures prescribed by the applicable 
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rules will apply. We agree to pay our respective arbitration costs, except as 
otherwise required by rules of JAMS or NAF, as applicable, but the arbitrator can 
apportion these costs as appropriate. The arbitrator's decision and award is final 
and binding, and judgment on the award may be entered in any court with 
jurisdiction. 

If any party files a judicial or administrative action asserting a claim that is subject 
to arbitration and another party successfully stays such action or compels 
arbitration, the party filing that action must pay the other party's costs and 
expenses incurred in seeking such stay or compelling arbitration, including 
attorneys' fees.

If any portion of this Mandatory Arbitration of Disputes section is determined to 
be invalid or unenforceable, the remainder of the Section remains in full force and 
effect. 

Miscellaneous. You may notify us by calling us at 1-888-211-4PCS, or use that 
number to get our current address for written notice. We may send you notice to 
your last known address in our invoicing records, or by calling leaving you a voice 
message on your wireless device or home phone. Properly addressed written 
notice is effective three days after deposit in the U.S. mail, postage prepaid. This 
Agreement is governed by and must be construed under federal law and the laws 
of the State of Kansas, without regard to choice of law principles. If either of us 
waives or fails to enforce any requirement under this Agreement in any one 
instance, that does not waive our right to later enforce that requirement. If any 
part of this Agreement is held invalid or unenforceable, the rest of this Agreement 
remains in full force and effect. Section headings are for descriptive, non-
interpretive purposes only. You may not assign this Agreement to any other 
person or entity without our prior written approval. This Agreement (including 
any referenced documents and attachments) makes up the entire agreement 
between us and replaces all prior written or spoken agreements. 

© 2005 Sprint Nextel. All rights reserved. No reproduction in whole or in part 
without prior written approval. Sprint, the “Going Forward” logo and other 
trademarks are trademarks of Sprint Nextel. iDEN is a trademark of Motorola, Inc.
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Glossary

1X
One Times Radio Transmission Technology (the “one times” refers to the frequency 
spectrum). Supports Internet connections with data rates up to 153.6 kbps 
(downlink from the network) and 76.8 kbps (uplink to the network). Actual speed 
depends on the network conditions. Compare to 1xEV-DO.

1xEV-DO
A high-speed standard for cellular packet data communications. Supports Internet 
connections with data rates up to 2.4 Mbps (downlink from the network) and 
153.6 kbps (uplink to the network). Average data rates are roughly 700 kbps 
(downlink from the network) and 153.6 kbps (uplink to the network). Actual speed 
depends on the network conditions. Compare to 1X.

bps
bits per second—The actual data speed over the transmission medium.

CDMA
Code Division Multiple Access—A wideband spread spectrum technique used in 
digital cellular, personal communications services, and other wireless networks. 
Wide channels (1.25 MHz) are obtained through spread spectrum transmissions, 
thus allowing many active users to share the same channel. Each user is assigned 
a unique digital code, which differentiates the individual conversations on the 
same channel.

dBm
decibels relative to 1 milliwatt

dormant
The network switches the Sprint PCS Vision data connection into dormant mode if 
there is no traffic on the connection for some time. When you resume data traffic, 
the high-speed data connection becomes active.

ESN
Electronic Serial Number—The unique serial number assigned to the modem for 
cellular network use. The ESN is on the label on the card, and is also displayed in 
the Device Info & Diagnostics window (page 64).
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FCC
Federal Communications Commission—The U.S. federal agency that is responsible 
for interstate and foreign communications. The FCC regulates commercial and 
private radio spectrum management, sets rates for communications services, 
determines standards for equipment, and controls broadcast licensing. Consult 
www.fcc.gov.

IS
Interim Standard—After receiving industry consensus, the TIA forwards the 
standard to ANSI for approval.

kbps
kilobits per second—Actually 1000, not 1024, as used in computer memory size 
measurements of kilobytes.

LAN
Local Area Network

LED
Light Emitting Diode—A semiconductor diode that emits visible or infrared light.

Mbps
Megabits per second.

MHz
Mega-Hertz—One million cycles per second

PC Card
Add-in memory and communications cards for portable computers. PC Card is a 
trademark of the PCMCIA.

PCMCIA
Personal Computer Memory Card International Association—The organization that 
standardizes PC Cards.

PCS
Personal Communications Services—A cellular communication infrastructure.

roaming
A cellular subscriber is in an area where service is obtained from a cellular service 
provider other than Sprint.

http://www.fcc.gov
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Sprint PCS Connection Manager
Software that allows you to manage the Sprint PCS Connection Card’s actions and 
monitor your connections.

Sprint PCS Vision
Sprint’s advanced multimedia third generation services available on the network.

system tray
Usually located in the bottom right of the screen (near the clock). When Sprint PCS 

Connection Manager is running, it places an icon  in this area, which you can 
use to monitor the connection state (page 38). If you right-click the icon, a 
shortcut menu is displayed (page 52):

TIA
Telecommunications Industry Association—A standards setting trade organization, 
whose members provide communications and information technology products, 
systems, distribution services and professional services in the United States and 
around the world. Consult www.tiaonline.org.

ToolTip
Text that displays when you position the mouse pointer over an area of the screen 
(for example, over an indicator).

VPN
Virtual Private Network

WAN
Wide Area Network

http://www.tiaonline.org
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Index
Numerics
1-888-211-4PCS  28
1X, 1xEV-DO

description  5
amount of data transferred  42
automatically connect when ready  58
cannot connect  75
connect  41
coverage - determine  38
dormant indicator  34
end connection  42
transmit/receive indicator  34

A
About Sprint PCS Connection Manager  67
accessibility  82
account, access  28
account, setting up  24
Activating and Using PCS Service  24
activating the card  24
activation  24
activation code  25
Activation Wizard

overview  24
Activation Wizard button  58

aircraft  94
Alert Log  63
alerts  63
always on

billing  70
Always on top  56
Always show Welcome screens  58
Always-on connection  5
amount of data transferred  42
antenna, guidelines for use  86
AOL  70
approvals  81
assistance  28, 43
Authenticating  36
authentication  82
auto-launch Sprint PCS Connection 

Manager  33
Automatic (roaming option)  58
automatically connect to network  58
automatically start Sprint PCS Connection 

Manager  33
AutoPreview  71

B
bandwidth optimization

enable  59
indicator  34

Bandwidth Optimization On  59
basics  31
behavior when the Sprint PCS Connection 

Card is locked  44
billing, and always on  70
blasting  94
bookmarks  46
business usage  62

C
caching  59
call duration  62
Cannot connect to the Nationwide Sprint 

PCS Network  75
Card Locked  37
care and maintenance  11
CDMA

networks  4
roaming - description  4
signal strength indicator  34
specification  82

change the lock code  46
channel spacing  81
Check for updates once per month  56
Check Now button  56
Clear Log  63
Close Sprint PCS Connection Manager  40
COM port

diagnostic info  64
system requirements  9

compression
enable  59
indicator  34

conditions of service  95
connect  41
connect automatically  58
Connected  37
connected icon  38
Connecting  36
connecting icon  38
connection

alert log  63
Always-on  5
amount of data transferred  42
automatically connect when ready  58
cannot connect  75
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diagnostics  64
end  42
establish  41
history  62
issues  63
launching  41
make  41
states  35, 38

Connection History  62
Connection Manager

see Sprint PCS Connection Manager
connection states  38
contents of package  5
Could not prepare data services  75
coverage maps  28
coverage type - determine  38
Create Report  66
current  81
customer support  28

D
data compression

enable  59
indicator  34

data optimization
See data compression

data profile  26
data provisioning  26
data speeds  70
data transferred, amount of  42
default connection  41
delete Sprint PCS Connection Manager  47
Device Info & Diagnostics  64
diagnostics  64
dial-up account  70
dimensions  83
disconnect  42
Disconnected  36
disconnected icon  38
disk space required  9
Displaying system information  66
document number  89
dormant icon  38
driver installation  20
drop test  83

E
E911 & position location  82
edit

Sprint PCS Connection Manager settings  
54

Sprint PCS Vision connection  57
eject the card  21
electrical specifications  81
electronic serial number  25
encryption - required for IOTA  9
end a connection  42
environmental specifications  83
error messages - viewing  63
ESN  25
exit Sprint PCS Connection Manager  40
expand Sprint PCS Connection Manager  39
expanded view of Sprint PCS Connection 

Manager  39

F
FAQ  69
favorites  46
fax  82
FCC

compliance  86
ID  86

firmware upgrades  90
forgot the lock code  44
frequencies, transmit and receive  81
frequency stability  81
Frequently Asked Questions  69

G
General options in Settings window  55
Getting Help  27
Getting Started  7
glossary  107
GO automatically when ready  58
GO button  41
GO button is unavailable  75

H
hard drive space required  9
hazards  94
headset jack  83
Help

overview  28
alert log  63
contact number  28
device info and diagnostics  64
diagnostics  64
frequently asked questions  69
menu options  49
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online Help  43
Sprint Customer Service  28
Sprint.com  28
tests  64
troubleshooting  73

help, online  43
hibernation mode  71
high encryption  9
history  62
humidity  83

I
icons

Sprint PCS Connection Manager  34
system tray  38

Image Compression  60
image compression

configure  59
indicator  34

IMSI_S  26
indicators

Sprint PCS Connection Manager  34
system tray  38

information, system  64
initial lock code  43
Initializing  36
Insert your card  35
inserting the card  20
installation

overview  7
Installed files  66

Internet Over The Air  26
introduction  ii
invoice, request copy of  28
IOTA (Internet Over The Air)

description  26
IOTA Provisioning window  26
Unable to prepare data services  76

IOTA Provisioning window  26
IRQ  9

K
Keep Connection History  56
knowledge base  28

L
Launch when Windows starts  56
LED  80
liability, limitation of  90
life support equipment  94
light  80

Limitation of Liability  90
limitations of liability  90
links, access  46
lock card

immediately  44
upon startup  45

lock code
change  46
initial lock code  43
overview  43
warning  44

locked card
behavior when the Sprint PCS Connection 

Card is locked  44
change the lock code  46
initial lock code  43
unlock the card  45

log, alert  63
log, connection  62

M
maintenance  11
make a connection

always on  58
amount of data transferred  42
automatically  58
cannot connect  75
connect to Sprint PCS Vision  41

maps, coverage  28
MDN  26
medical equipment  94
memory required  9
Menu

all options  49
About Sprint PCS Connection Manager  67
Alert Log  63
Connection History  62
Device Info & Diagnostics  64
Exit  42
Links  46
Menu button  34
Settings  54
Software Updates  66
system tray menu  52

Menu button  34
menu options

Sprint PCS Connection Manager menu  49
system tray menu  52

messages - viewing  63
minimize on startup  56
minimize Sprint PCS Connection Manager
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immediately  40
on startup  56

minus sign in Sprint PCS Connection 
Manager  39

Mobile IP  82
MSID (Mobile System ID)  25, 26

N
NAM  82
Nationwide Sprint PCS Network

amount of data transferred  42
automatically connect when ready  58
availability status  64
cannot connect  75
connect - Sprint PCS Vision  41
coverage - determine  38
frequently asked questions  69

network
always on connection  58
amount of data transferred  42
availability status  64
cannot connect  75
CDMA wireless network, description  4
connect  41
coverage - determine  38
optimization settings  59
performance, improve  59
roaming options  58
signal strength indicator  34

non-expanded view of Sprint PCS 
Connection Manager  39

non-preactivated card  24
not in service  75
notices  93
notices, regulatory  86

O
on top, always  56
online Help  43
operating temperature  83
optimization

enable  59
indicator  34

optimize performance  71
optimize settings  59
OTAPA  82
OTASP  82
Outlook integration  8

P
package contents  5

patents  88
PCS Connection Manager

see Sprint PCS Connection Manager
PCS Vision

see Sprint PCS Vision
performance, improve  59, 71
personal usage  62
phone number

during Activation Wizard  26
Sprint PCS Connection Card  43

planes  94
Play sound effects  56
plus sign in Sprint PCS Connection Manager  

39
port configuration  64
position location  82
power button  83
preactivated card  24
preferred roaming list  82
Preview Pane  71
PRL  82
problems  73
products, Sprint PCS  46
profile - data  26
properties of connection, change  57
Protocol Compression  60
provisioning  24, 26

Q
questions

See troubleshooting

R
radio frequency specifications  81
receive frequencies  81
records of connection history  62
regulatory information  85
regulatory notices  86
Relock card when program exits  45
remove Sprint PCS Connection Manager  47
remove the card  21
report of system information  66
restore Sprint PCS Connection Manager  40
RF specifications  81
Roam Only (roaming option)  58
roaming

description  4
PRL  82
settings  58

RSSI  34, 64
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Running Diagnostics  64

S
Safety and Hazards  94
Safety and Notices  93
SAR  86
Searching for service  36
security

overview of user lock  43
warning  44
behavior when the Sprint PCS Connection 

Card is locked  44
change the lock code  46
high encryption - required for IOTA  9
IOTA - high encryption requirement  9
lock card immediately  44
lock card upon startup  45
unlock card  45

service - not in  75
service plan, add options  28
service, conditions of  95
services, Sprint PCS  46
Setting Up Service  23
Settings window

overview  54
General  55
Optimization  59
Sprint PCS Vision  57

shortcut menu  52
show Welcome screens  58
signal strength

diagnostic tests  64
indicator  34

SMS  82
software

components  10
lock card immediately  44
lock card upon startup  45
menu options  49
minimize  40
minimize on startup  56
remove  47
restore minimized  40
specifications  82
uninstall  47
unlock card  45
update  66
upgrading Windows  76
user lock  43
version information  67
Windows, upgrading  76

Software Updates  66
sound effects, play  56
specifications

environmental  83
mechanical  83
radio frequency and electrical  81
software  82

speeds, data transmission  70
Sprint (roaming option)  58
Sprint Customer Service  28
Sprint PCS Connection Card

inserting  20
phone number  43

Sprint PCS Connection Manager
overview  32
About Sprint PCS Connection Manager  67
amount of data transferred  42
automatically connect when ready  58
cannot connect  75
close  40
configure  54
expand Sprint PCS Connection Manager  

39
FAQ  69
frequently asked questions  69
icons  34
icons in system tray  38
links  46
menu options  49
minimize  40
minimize on startup  56
remove  47
restore  40
security features  43
settings  54
start  32
start automatically  33
stopped working after Windows upgrade  

76
system tray menu  52
uninstall  47
updates  66
upgrading Windows  76
version information  67
window overview  33
Windows upgrade  76

Sprint PCS Connection Manager settings
change  54
compression  59
General  55
Optimization  59
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Sprint PCS Connection Manager stopped 
working after I’ve upgraded to a different 
version of Windows  76

Sprint PCS products and services  46
Sprint PCS Services

Sprint Customer Service  28
Sprint PCS Vision

Always show Welcome screens  58
amount of data transferred  42
automatically connect when ready  58
cannot connect  75
connect  41
coverage - determine  38
disconnect  42
end connection  42
settings  57

Sprint roaming  58
Sprint web site  28
Sprint, contacting  28
Sprint.com  28
standby current  81
start a connection

automatically connect when ready  58
immediately  41

Start in system tray  56
start Sprint PCS Connection Manager

automatically  33
manually  32

states of connection  35
status information  64
status of connection  35
Stop button  42
stop the card  21
storage temperature  83
support  28
system information  64, 66
System parameters  66
system tray

connection states  38
icons  38
menu  52
shortcut menu  52
start in  56

T
taskbar icon

shortcut menu  40
TCP/IP optimization

enable  59
indicator  34

technical specifications  79
technical support  28
telephone number of card  43
temperature

operating  83
storage  83

Terms and Conditions  95
terms and definitions (glossary)  107
tests

run diagnostic tests  64
trademarks  89
transferred data, amount of  42
transmission speeds  70
transmit frequencies  81
transmit/receive icon  34
transmitter power  81
troubleshooting

common causes of problems  74
alert log  63
cannot connect  75
contact information  28
Could not prepare data services  75
FAQ  69
GO button is unavailable  75
not in service  75
run diagnostic tests  64
stopped working after Windows upgrade  

76
Troubleshooting wizard  28
Unable to prepare data services  76
wizard  28

Troubleshooting wizard  28
TTY  82
type of coverage - determine  38

U
uninstall Sprint PCS Connection Manager  

47
unlock the card

initial lock code  43
instructions  45

Update Data Profile  26
update the software  66
updates, check for latest  90
Updating User Profile…  26
upgrading Windows  76
URLs - favorites  46
USB port  64
user lock

overview  43
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warning  44
change the lock code  46
lock card immediately  44
lock card upon startup  45
unlock the card  45

User Lock Change button  58

V
vehicle, operating  94
version information  67
vibration  83
Viewing your phone number  43
views of Sprint PCS Connection Manager  39
Vision

see Sprint PCS Vision
Voice  82
voltage  81
VPN  70

W
warning

lock code, regarding  44
weak signal  75
web site, Sprint.com  28
web sites - favorites  46
Welcome screen, always show  58
white paper  71
Windows

auto-launch Sprint PCS Connection 
Manager  56

upgrading  76
wizard

Activation Wizard  24
Troubleshooting  28

www.sprint.com  28
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